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Introduction
Using these Materials

The QuarkEd for QuarkXPress lessons contain a minimum of text so you
can concentrate on doing rather than on reading. However, enough infor-
mation is included so that after you complete the lessons, you can try out
the exercises on your own using the text and the accompanying CD-ROM.

Each lesson starts with a new file that includes all the necessary elements
from the previous lessons, so if you delete or change elements in one
lesson, you won’t miss anything in another lesson.
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Getting Started

QuarkEd for QuarkXPress has two parts: the instruction documents containing
the lessons and the sample electronic files necessary to complete the lessons.
The files for both parts are on the QuarkEd CD-ROM. 

About the modules

If you’re new to QuarkXPress, start with Module 1: QuarkXPress Fundamentals.
This module contains four lessons that give you an opportunity to work with
text, pictures, and other QuarkXPress elements as you complete a simple docu-
ment and prepare it for printing. When you finish these lessons, you’ll have
covered all the information you need to create your own QuarkXPress project.

If you’ve used QuarkXPress before, skim through Module 1 to make sure you’re
familiar with the information, then proceed to Module 2: QuarkXPress Essentials.
This module contains eight lessons that teach you how to construct documents,
work with color, format text with style sheets, fine-tune typography, combine
type and graphics, prepare documents for high-resolution printing, and other
topics. The lessons in this book will help you work more efficiently and produc-
tively in QuarkXPress.

If you are already proficient in QuarkXPress — or have completed Modules 1
and 2 — you may want to explore Module 3: Advanced Techniques. This module
contains six lessons that teach you how to use QuarkXPress as an illustration
tool, how to increase your productivity in QuarkXPress, and how to publish long
documents using the books, lists (table of contents), and indexing features.

About the lessons

The modules are divided into individual lessons, which build on information
learned in previous lessons. However, you do not need to complete all the
lessons. You may choose the lessons relevant to you and skip others. 

Each lesson is divided into two sections: “The Steps” and “The Details.” “The
Steps” section presents a series of tasks that make up the hands-on portion of a
lesson. Tasks don’t contain a lot of text, but provide the information you need
to complete a lesson and serve as a “how-to guide” after class. Each section of
steps ends with a “Checkpoint” page that suggests various ways to check your
skills, and presents additional ideas for further exploration. 

“The Details” contain the reference section of a lesson. Included is in-depth
information related to topics covered in “The Steps.” This is a great place to
start when you want to learn more about a particular topic or feature. 
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Other reference books

Another source of information is the documentation that comes with the
QuarkXPress software. The documentation includes a complete user guide, A
Guide to QuarkXPress; a tutorial, A Preview to QuarkXPress; and various other
booklets and electronic files.

H Printing modules and lessons: The QuarkEd for QuarkXPress instruction
documents are in the form of Adobe Acrobat files on the CD-ROM. Once

you’ve determined which modules and lessons are appropriate, you can print
those portions from the Acrobat Reader. 
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Conventions

What’s ahead

Each lesson begins with a brief overview of what you’ll learn. When applicable,
a finished version of the lesson file is included so you can open it to see where
you’re heading.

Lessons and tasks

Lessons are made up of individual tasks that cover a concept, procedure, or
feature. Individual tasks are made up of a series of numbered steps that are
divided into two parts — the what you’ll do part includes minimal details in
bold type face; the how you’ll do it part lists specific details and tools you’ll
need to complete the step (in plain type face). What you’ll do appears on the
first line of a numbered step; how you’ll do it appears on subsequent lines.

For example:

.1 Copy the picture box on page 1: Using the Item tool e, click to select
the picture box containing the “Color Pastels.tif” picture file.

Choose Edit & Copy.

Menu paths

Menu paths are indicated by arrows &. For example, the following instruction
asks you to open the Print dialog box by choosing the Print command from
the File menu:

Choose File & Print to open the Print dialog box.

Information you enter

Information you need to type appears in a typewriter type font. For example:

Using the Content tool E, click to select the text box; then type color.
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Screen captures and tables

Screen captures are often used to provide visual examples or avoid unnecessary
explanatory text. Tables sometimes accompany or replace screen captures so
you can quickly check settings as you perform a task. 

In the following example, you have a screen capture for a visual reference, along
with a table showing the exact settings you need to make:

Choose Item & Step and Repeat to open the Step and Repeat dialog box:

The Step and Repeat dialog box lets you specify the number of copies QuarkXPress
makes of an active item, and how far the copies are offset horizontally and vertically
from the original and each other.

Enter these settings, then click OK:

Field Setting

Repeat Count 3
Horizontal Offset 0 pt
Vertical Offset 50 pt

Tips, keyboard commands, and notes

The sidebar contains tips relating to a task, as well as keyboard commands used
on that particular page. 

Tips
Tips include information that’s helpful or useful, but may not directly affect your
performance of a task. Tips often provide background information or suggest an
easier or more efficient way to accomplish a particular function. 

For example:

H Moving the Tool palette: By default, the Tool palette appears to the left
of the document window, but it can be moved by dragging the shaded

bar at the top of the palette.
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Keyboard commands
Keyboard commands list a key or combination of keys that you can press to
perform a particular function without using your mouse. The keyboard
commands immediately follow each task’s instructions.

For example:

J Keyboard Commands for Mac OS: 

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+P

J Keyboard Commands for Windows:

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+P

When keyboard commands appear in text, they are listed with Mac OS
commands first, followed by Windows commands and separated by a slash.
For example:

To make the document window update as you scroll, press Option/ALT

while dragging the scroll box.

The following symbols are commonly used to represent particular keys on
Mac OS:

• Command key: C

• Option key: `

• Shift key: w

• Control key: ^

Notes
Notes appear in the main body of text because they contain information that
can have a direct impact on your understanding of a task or its outcome. 

For example:

G If you import a picture into a box that already contains a picture, the
existing picture will be replaced by the new one.

H Saving while performing lessons: Each lesson in QuarkEd directs you
to create or to open a file, then name and save it. Steps in the lessons do

not instruct you to save thereafter — you should save as often as you normally
would while working on a computer. This means save often.
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Setting Up

Before starting QuarkEd, be sure QuarkXPress, the appropriate fonts, and the
necessary lesson files are on your machine. 

QuarkXPress software

There are a few things to check inside your QuarkXPress program folder before
getting started. 

First, locate the file called XPress Preferences. The XPress Preferences file stores
default settings that dictate how various QuarkXPress features work — and there-
fore may affect steps in the QuarkEd lessons. If you’re working with a new copy
of QuarkXPress, the preferences will contain the Quark-specified defaults and
you will not need to worry about it. If this is a working copy of QuarkXPress used
in a publishing environment, the XPress Preferences may contain hours worth of
modifications. If you suspect that is the case, place the file in a separate folder for
the duration of the lessons. When you launch QuarkXPress, it will create a new
“factory” preferences that you can use to complete the lessons. 

The second thing to check is the “XTension” folder within your QuarkXPress
folder. XTensions™ software expands the capabilities of QuarkXPress by adding
features, menu commands, tools, etc. Make sure the following files are in the
XTension folder: Cool Blends™, JPEG Import, LZW Import, XPress Tags Filter.
Check the “XTension Disabled” folder for any missing files.

Fonts

To simplify font issues, the Mac OS sample documents contain only Helvetica
and Times fonts; the Windows sample documents contain Arial and Times
New Roman fonts.
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Lesson files

The lesson files are in folders labeled “Module 1,” “Module 2,” and “Module 3.”
Drag the appropriate module’s folders to your hard drive. If space is limited,
copy one module at a time, or copy only the files for the lessons within each
module that you intend to complete. Each module’s folder contains a “Student
Files” folder for you to store files in while you’re working. You can delete these
files when you finish a module. 

H Launching QuarkXPress: It might be helpful to create an alias or
shortcut for QuarkXPress so you can use a desktop icon to easily

launch the program.

HWorking with a demonstration version: If you do not own QuarkXPress,
the QuarkEd CD-ROM provides a demonstration version of the software

that you can use to complete the lessons. However, you cannot save files with
the demonstration version, so you should skip over those steps in the lessons.
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1
The Concepts
What’s Ahead

QuarkXPress is electronic publishing software. You can use it to create any
kind of publication, from black-and-white business cards to multicolor
magazines. To use QuarkXPress effectively, you need to understand some
basic concepts. 

This lesson will introduce you to concepts and interface features that are
fundamental to QuarkXPress. To see the finished document, open “Color
Final.qxt” in the “Lesson 1” folder inside the “Module 1” folder.
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The Steps: Opening an Existing Document

Opening an Existing Document

In this task you’ll open a partially completed page from an article about color.
Later you’ll examine important concepts and interface conventions as you
complete the page.

J Keyboard Commands for Mac OS: 

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+S

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+S

J Keyboard Commands for Windows:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+S

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+S

.1 Launch QuarkXPress: If QuarkXPress isn’t running, locate the
QuarkXPress icon and double-click it.

.2 Display the Open dialog box: Choose File & Open.

The Open dialog box shows the QuarkXPress version that created a document and
the document type. 
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.3 Open the “Color Begin.qxt” file: Open the “Module 1” folder, then
open the “Lesson 1” folder. Select the “Color Begin.qxt” template and

click Open. 

G If the Nonmatching Preferences dialog box displays, click Keep
Document Settings. If the Missing Fonts dialog box displays, click
Continue. A new document based on the template appears in the
document window.

.4 Change the document view: If you can’t see the entire document page
and the pasteboard surrounding it, choose View & Fit in Window. The

document page is centered in the document window.

The pasteboard surrounding each page or spread can be used to store QuarkXPress
elements. Items on the pasteboard, such as the dotted rectangle containing the
word “color,” won’t print unless they overlap a document page.

.5 Save the document in the Student Files folder: Choose File & Save as
to display the Save as dialog box. Locate and open the “Student Files”

folder inside the “Module 1” folder.
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Enter a descriptive name for the file such as “My Color Doc.qxd.” (Use the
three-character extension “.qxd” in the name.) 

Verify that the Type is Document(s) and the Version is 4.0, then click Save.

H Opening templates: When you open a template, QuarkXPress creates a
new copy of the original document for you to work on. This lets you make

changes to the copy without affecting the original. (Therefore, all QuarkEd lesson
files are saved as templates.) If you want to apply changes to a template, simply
use the same name and replace the existing file.

H Fitting a spread in the document window: You can fit an entire spread
and the pasteboard in the document window by pressing Option/ALT

while choosing Fit in Window.

H Naming files: Adding the ”.qxd” extension to file names ensures that both
Mac OS and Windows will recognize the files as QuarkXPress documents.

(Windows adds extensions to file names automatically, but you can also enter
them manually as you would on Mac OS.) The “.qxt” extension identifies files as
QuarkXPress templates.
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The Steps: Examining the Tool Palette

Examining the Tool Palette

Often, you can use menu commands, keyboard commands, or palettes to
perform the same task. Palettes are movable windows that contain related
controls or tools. Two of the most frequently used QuarkXPress palettes are
the Measurements palette and the Tool palette. In this task you’ll examine
the Tool palette.

J Keyboard Commands for Mac OS: 

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Application Preferences  . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+Y

J Keyboard Commands for Windows:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Application Preferences  . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+Y

.1 Display the Tool palette: If the Tool palette isn’t open, choose View &
Show Tools.

Tools create and edit elements such as text boxes, picture boxes, lines, text paths,
text, and pictures. When you click a tool to select it, its icon is highlighted.
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.2 Open the Application Preferences dialog box and enable Tool Tips:
Choose Edit & Preferences & Application.

Click the Interactive tab.

In the lower right of the tab, locate the Show Tool Tips box and make sure it’s
checked. Click OK.

The Interactive tab lets you control many of the ways you interact with QuarkXPress.
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.3 Display tool names: Move the pointer over a tool in the Tool palette to
display its name. There may be a slight delay before the tool name appears.

Place the cursor over other tools to display their names. You’ll learn what each
tool does as you use it.

When the pointer is placed over a tool, its name displays whether or not the tool
is selected.

.4 Look at the “pop-out” tools: Click and hold one of the tools with a
small arrow in its upper right corner (for example, the Rectangle Text

Box tool T¶). 

Notice the additional tools. “The Details” section of this lesson explains how
you can customize the Tool palette by adding hidden tools or removing some
of the existing ones. 

H Moving the Tool palette: By default, the Tool palette appears to the left
of the document window, but it can be moved by dragging the shaded

bar at the top of the palette.

H Turning off Tool Tips: Once you become familiar with QuarkXPress, the
Tool Tips may get in your way. To turn the feature off, simply uncheck

Show Tool Tips in the Interactive tab of the Application Preferences dialog
box (Edit menu). 
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Creating Guides

Guides are nonprinting lines used to position items on a page. You specify
margin guides when you create a new document. For positioning page ele-
ments, you can drag ruler guides onto a document page from the rulers. In
this task you’ll create horizontal and vertical ruler guides.

J Keyboard Commands for Mac OS: 

Show/Hide Rulers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C+R

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . F7

J Keyboard Commands for Windows:

Show/Hide Rulers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . CTRL+R

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . F7

.1 Display Rulers and Guides: If rulers aren’t showing choose View & Show
Rulers. Rulers appear at the top and left of the document window.

If guides aren’t showing choose View & Show Guides. Margin Guides appear
around the edges of the document page.

.2 Create a horizontal guide: Click the Item tool e in the Tool palette. Move
the Arrow pointer a over the ruler at the top of the document window.

Click the ruler to display the g pointer and drag approximately 1.25" down the
document page (use the left ruler as a reference). When you release the mouse
button, a horizontal guide displays.

Nonprinting guides can be pulled from the rulers at the top and left of the document
page when the Show Guides command (View menu) is enabled.
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.4 Create a vertical guide: Move the Arrow pointer a over the ruler at the
left of the document window. 

Click the ruler to display the G pointer and drag approximately 3" across the
document page (use the top ruler as a reference). When you release the mouse
button, a vertical guide displays.

Ruler guides appear as green lines by default, but you can assign other colors to
them in the Display tab in the Application Preferences dialog box.

H Identifying guides: By default, on color monitors, margin guides are
displayed as blue lines and ruler guides are displayed as green lines.

QuarkXPress automatically places margin guides in all new documents. You
specify their position in the Margin Guides fields in the New Document
dialog box. Ruler guides are guides that you create by dragging them off the
horizontal and vertical rulers. 

H Displaying ruler guides: You can control whether ruler guides display
In Front or Behind QuarkXPress elements using the Guides menu in

the General tab of the Document Preferences dialog box.
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Navigating through QuarkXPress

The QuarkXPress document window functions like windows in most other
Mac OS and Windows applications. You move and resize document windows
as you would any other program’s windows. In this task you’ll learn to navi-
gate within a QuarkXPress window — within a page and from page to page.

J Keyboard Commands for Mac OS: 

Page Grabber Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . .`

Go to Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+J

J Keyboard Commands for Windows:

Page Grabber Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . .ALT

Go to Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+J

.1 Use the scroll bars to move the page around: Click the arrows on the
bottom and right sides of the document window, then try dragging the

box inside the scroll bars. 

This moves the page around. In documents with multiple pages, the scroll bars
let you navigate to other pages as well.

The arrows and boxes in the scroll bars allow you to move around within a page
or document.

.2 Use the Page Grabber Hand to move around within the page: Press
Option/ALT to display the Page Grabber Hand H. Move the mouse

around to move the page. 

.3 Locate the Go to Page dialog box: Choose Page & Go to. You can enter
page numbers in this dialog box to quickly jump to another page.

Since this document has only one page, click Cancel.
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.4 Locate the go-to-page pop-up menu: In the lower left corner of the docu-
ment window, locate the small triangle , (next to the far left scroll arrow). 

Click the arrow to display icons for the master pages and document pages.
Selecting a page icon displays that page in the document window.

The go-to-page pop-out menu provides a quick, visual method for switching pages
in a document.

H Switching pages in a document: The Document Layout palette
(View menu) displays an icon for each master page and document

page in a document. Double-clicking an icon displays that page in the
document window. As you become more familiar with QuarkXPress, you’ll
discover favorite keyboard commands that allow you to navigate between
pages as well.
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Working with Items

The distinction between “items” and “contents” is fundamental to QuarkXPress.
“Items” are text boxes, text paths, picture boxes, and lines. Text and picture-
related items support contents. “Contents” are text and pictures. Before you can
add text to a document, you must create a text box or a text path to contain it.
Before you can add pictures, you must create a picture box. To manipulate items,
you’ll usually need to select the Item tool e. In this task you’ll move and resize
an existing text box.

J Keyboard Commands for Mac OS:

Snap to Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .w+F7

J Keyboard Commands for Windows:

Snap to Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .SHIFT+F7

.1 Select the Item Tool e: If necessary, click the Item tool e in the
Tool palette.

.2 Select a text box: Click the text box on the pasteboard containing the
word “color.” When you click the text box, it becomes active — the border

becomes solid, and resizing handles appear at each corner and on each side.

A dotted outline depicts inactive boxes when guides are enabled (left). Active boxes
display solid borders and resizing handles (right).

For comparison with the text boxes above, this example shows an inactive picture
box (left) and an active picture box (right). 
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.3 Enable the Snap to Guides feature: Choose the View menu and make
sure a checkmark appears beside Snap to Guides. Because this command

“toggles” on and off, don’t highlight it if it is already checked.

.4 Move the “color” text box to the document page: Using the Item
tool e to drag the text box, align its upper left corner with the guides you

created earlier. As you drag the text box into position, it “snaps” to the guides.

The “color” text box is positioned on the document page.
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.5 Resize the text box: Move the Item tool e over the resizing handle on
the right side of the text box to display the Resizing pointer f.

Drag the resizing handle to the right margin guide. As you drag the handle, the
text box gets wider and its right side snaps to the margin guide.

The text box is extended to the right margin guide.

H Distinguishing text boxes from picture boxes: When Guides are show-
ing, an empty picture box can be distinguished from an empty text box

by the “X” pattern in the picture box.

H Switching between the Item and Content tool: To toggle between the
Item e and Content E tools press Shift+F8. When the Content tool E

is selected, you can select the Item tool e temporarily by pressing C/CTRL.

H Snapping items to guides: The Snap to Guides feature helps you
quickly align items with ruler guides and page guides. When Snap to

Guides is checked and you drag an item within the snap distance, the item
seems to “jump” to the guide. The Snap Distance is specified in pixels in the
General tab of the Document Preferences dialog box.
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Modifying Items

The Modify dialog box lets you change several specifications for an active item
in a single dialog box. Like many menus, windows, and palettes in QuarkXPress,
the Modify dialog box is context-sensitive so its tabs vary depending on the
active item. In this task you’ll resize a text box using the Modify dialog box
instead of the Item tool e.

J Keyboard Commands for Mac OS:

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+1

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+M

J Keyboard Commands for Windows:

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+1

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+M

.1 Display the document at actual size: Choose View & Actual Size.
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.2 Open the Modify dialog box: If necessary, click to activate the text box,
then choose Item & Modify. 

Tabs in the Modify dialog box vary depending on the type of item that is active.
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.3 Change the height of the text box: Enter 2.5 in the Height field of
the Box tab, then click OK.

The height of the text box increases to 2.5".

H Navigating through fields: To highlight the next field in a palette or dia-
log box press the Tab key. To highlight the previous field, press Shift+Tab.

H Navigating through tabs: To display the next tab in a dialog box on
Mac OS, press C+Tab. To highlight the previous tab in a dialog box,

press C+Shift+Tab. To display the next tab in a dialog box on Windows, press
CTRL+TAB. To highlight the previous tab in a dialog box, press CTRL+SHIFT+TAB.
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Working with Contents

To manipulate contents, select the Content tool E. In this task you’ll use the
Content tool E to highlight text, then you’ll modify the text using commands
in the Style menu.

J Keyboard Commands for Mac OS:

Centered Alignment  . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+C

Other Size (font)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+\

J Keyboard Commands for Windows:

Centered Alignment  . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+C

Other Size (font)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+\

.1 Select the Content tool E: Click the Content tool E in the Tool palette.

.2 Change the text alignment: Click and drag the Content tool E over the
word “color” to highlight it, then choose Style & Alignment & Centered.
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.3 Change the font size: Make sure the text is still highlighted, then choose
Style & Size & Other. The Character Attributes dialog box opens with

the Size field highlighted. 

From the Style menu you can choose preset font sizes in the Size submenu, or
choose Other to set font sizes manually in the Character Attributes dialog box.

Enter 150 in the Size field.

Click OK.
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Using the Measurements Palette

The Measurements palette lets you modify many item and content attributes.
Generally, the left side of the palette lets you modify items and the right side
lets you modify contents. In this task you’ll use the Measurements palette to
resize a picture box and modify the picture it contains.

J Keyboard Commands for Mac OS:

Show/Hide Measurements  . . . . . . . . . . . . . . . . . . . . . .F9

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . .F7

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+W

J Keyboard Commands for Windows:

Show/Hide Measurements  . . . . . . . . . . . . . . . . . . . . . .F9

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . .F7

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+F4
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.1 Scroll to see the existing picture box containing an image of artists’
pastels: If necessary, click the horizontal scroll arrows to scroll across the

page or the vertical scroll arrows to scroll up or down the page.

The existing picture box is shown in the upper left corner of the document window. 

.2 Select the picture box: Using either the Item tool e or Content tool E,
click the picture box.

.3 If necessary, display the Measurements palette: Choose View &
Show Measurements.

Using the shaded bar at the left of the Measurements palette, drag it to a
convenient location such as the bottom of the screen. 
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.4 Resize the picture box: Using either the Item tool e or Content
tool E, click and drag the pointer over the value in the H field of

the Measurements palette to highlight it.

Enter 3.75, then press Return/ENTERr.

The H field reflects the height of the picture box.

.5 Resize the picture: Click and drag the pointer over the value in the X%
field (100%) on the right side of the Measurements palette to highlight it.

Enter 60 to scale the picture horizontally.

Press Tab to highlight the value in the Y% field (100%) on the right side of the
Measurements palette.

Enter 60 to scale the picture vertically.

Press Return/ENTERr.

The X% and Y% fields reflect the scale of the picture.

.6 Hide the document’s guides: Choose View & Hide Guides.

.7 Change the document view and deselect the picture box: Choose
View & Fit in Window, then click the pasteboard to see the results

of your changes.

.8 Close and save the document: Choose File & Close. If you haven’t
recently saved your document, a dialog box asks you to save it. Click Yes.

H Sizing and positioning items using the Measurements palette:
Items may be precisely sized or positioned by highlighting fields in

the Measurements palette, then entering desired values. To highlight a
field, click and drag the pointer over it or double-click the field.
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Checkpoint

Confirm your new skills — then try them out. If you have any questions, ask
your instructor or consult “The Details” section of this lesson.

How are you doing?

Make sure you can:

• Open an existing document

• Save a document

• Create and use guides

• Determine which tools are text-related and which are picture-related

• Determine which tools or menus you would use to manipulate items
or contents

• Manipulate items and contents using the Measurements palette

On your own

Experiment with new documents or open some of the other lesson files.
Try the following:

• Create a few more vertical and horizontal guides by dragging them off
the rulers.

• Move guides or drag them off the page — notice what happens in the
Measurements palette as you move guides.

• Try turning Snap to Guides (View menu) on and off, then move items
toward guides — notice the difference Snap to Guides makes.

• Select a text box that contains a lot of text and change the font size or
the alignment.

G The lesson files are all templates, which means you can open copies of
them without affecting the original files.
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Documents

QuarkXPress lets you create documents from scratch, build documents based
on existing templates, and work with previously saved documents. Documents
can consist of single pages or spreads with left- and right-facing pages.

Opening files

QuarkXPress allows you to have up to 25 documents, templates, or libraries
open at one time. Using the current version of QuarkXPress, you can open
documents saved in version 2.1 or later. To open a file, use the Open com-
mand in the File menu.

• If your document contains preference settings that are different from those in
your XPress Preferences file, the Nonmatching Preferences dialog box opens.
To use settings saved with the document, click Keep Document Settings. To
update the document to the XPress Preferences on your machine, click Use
XPress Preferences. Updating settings could cause text to reflow.

• If your document contains fonts not installed on your system, the Missing
Fonts dialog box displays. If you click Continue, QuarkXPress automatically
displays system fonts for the missing fonts. The fonts specified in the docu-
ment don’t change. To display a list of missing fonts, click List Fonts; then
you can choose other fonts to permanently replace them.

The pasteboard

The pasteboard is a nonprinting area that surrounds individual pages and
spreads. The pasteboard can be used as a work area, a temporary storage area,
or to “bleed” items off a page. The pasteboard works as follows:

• Scroll left or right to view the pasteboard. Create, position, or group items
on the pasteboard just as you would on a document page.

• To move an item from the pasteboard to a document page or another paste-
board, select the Item tool e, click the item; then drag it into position.

• When you create a horizontal ruler guide and release the g pointer over the
pasteboard, the guide displays across the pasteboard and all the pages in a
spread. If you release the g pointer over a document page, the guide displays
only on the page.

• Bleed is the term used to describe items that are printed to the edge of a finished
page. To create a bleed item, extend the item from a document page onto the
pasteboard. Once a document with bleed elements is reproduced on press, a
commercial printer can trim it to its finished page size. 
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Saving documents

The Save command records changes to your documents. When you choose
Revert to Saved, QuarkXPress discards the changes made since the last time
you saved. The Save as command lets you name and save a new document or
create a copy of an existing document. To use Save as: 

• Choose Save as (File menu). Use the controls in the dialog box to specify a
location for the new document file, then enter a name for the document in
the Save current document as field. 

• Choose a QuarkXPress file format version from the Version menu. Earlier
versions of QuarkXPress are unable to open documents saved in the current
version. Items based on features exclusive to the current version will be modi-
fied or stripped from documents saved in the 3.3 format.

• On Mac OS, check Include Preview to create a thumbnail preview of the
document for display in the Open dialog box; then click Save.

H Customizing the pasteboard width: To adjust the width of the paste-
board, click the Interactive tab of the Application Preferences dialog

box, then enter a value in the Pasteboard Width field. Pasteboard Width is
measured as a percentage of the document width. You can specify a value from
0% to 100%. At least .5" of pasteboard will always surround document pages
and the pasteboard width cannot exceed 48". The default width value is 100%.

41



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 1: The Concepts

The Details: Tool Palette

Tool Palette

The tools in the Tool palette are used to create and edit many elements in
QuarkXPress, including text boxes, picture boxes, lines, text paths, text, and pic-
tures. The tool you select determines which QuarkXPress commands are available. 

• To display the Tool palette, choose View & Show Tools. The Tool palette
remains open until you close it. To close the Tool palette, choose View &
Hide Tools or click the close box. 

• To select a tool, click it. Press C+Tab/CTRL+ALT+TAB to select the tool below
the current tool; press C+Shift+Tab/CTRL+ALT+SHIFT+TAB to select the tool
above the current tool. 

• To specify default settings for magnification and item creation through
the Tools tab of the Document Preferences dialog box, choose Edit &
Preferences & Document. You can also access the Tools tab by double-
clicking an item creation tool or the Zoom tool Z. Tool preferences apply
to the active document; if no documents are open, tool preferences become
application defaults.

J Keyboard Commands for Mac OS:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Show/Hide individual tool  . . . . . . . . . . . . . . . . . . . . . .^+click

Select next tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+Tab

Select previous tool . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+Tab

Keep tool selected  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .`+click

Page Grabber Hand H* . . . . . . . . . . . . . . . . . . . . . . . . .`

Zoom in pointer M . . . . . . . . . . . . . . . . . . . . . . . . . . . .^

Zoom out pointer m . . . . . . . . . . . . . . . . . . . . . . . . . . .`+^

*The Page Grabber Hand H is not accessible when the Zoom tool Z is selected
or when Caps Lock is enabled.
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J Keyboard Commands for Windows:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Show/Hide individual tool  . . . . . . . . . . . . . . . . . . . . . .CTRL+click

Select next tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+TAB

Select previous tool . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+TAB

Keep tool selected  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .ALT+click

Page Grabber Hand H* . . . . . . . . . . . . . . . . . . . . . . . . .ALT

Zoom in pointer M . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SPACE

Zoom out pointer m . . . . . . . . . . . . . . . . . . . . . . . . . . .ALT+CTRL+SPACE

*The Page Grabber Hand H is not accessible when the Zoom tool Z is selected.

Default Tool palette

The basic function of each tool in the Tool palette is described below: 

e Item tool selects, moves, resizes, and reshapes items (boxes, lines, text paths,
and groups), and reshapes clipping and runaround paths.

E Content tool imports and edits text and pictures, and imitates most Item
tool functionality.

R Rotation tool rotates items visually rather than numerically.

Z Zoom tool enlarges or reduces the document view.

T Rectangle Text Box tool creates a rectangular text box; provides access to
other text box tools. 

p, x, ç, ∂ Picture Box tools create a rectangle, rounded-corner, oval, or
Bézier picture box; the Rectangle Picture Box tool p provides access to other
picture box tools.

L Line tool creates straight lines of any angle; provides access to other line tools.

o Orthogonal Line tool creates perfectly horizontal or vertical straight lines.

Ò Line Text-Path tool creates a straight line of any angle, that supports text;
provides access to other text-path tools.

u Linking tool establishes text chains among text boxes or text paths.

U Unlinking tool breaks links among text boxes or text paths.

H Page Grabber Hand (not displayed in palette) scrolls a page in any direction.
To use, press Option/ALT — except when the Zoom tool Z is selected, and on
Mac OS when Caps Lock is enabled.
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Pop-out tools

Å, ı, Ç, Î, ´, Ô Text Box tools create a rounded-corner, concave-corner,
beveled-corner, oval, Bézier, or freehand Bézier text box.

å, ∫, ƒ Picture Box tools create a concave-corner, beveled-corner, or freehand
Bézier picture box.

∞, § Line tools create a Bézier line or freehand Bézier line.

, Â, ˜ Text-Path tools create an orthogonal, Bézier, or freehand Bézier
text path.

Customizing the Tool palette

QuarkXPress lets you customize the Tool palette by rearranging, hiding, and
adding tools. Many tools are condensed under “pop-outs” indicated by a
triangular arrow on the tool icon.

• To display pop-out tools, click and hold a tool that has an arrow on its icon. 

• To select a pop-out tool and replace a tool on the main palette, click the tool
on the main palette and drag to the pop-out tool.

• To add a pop-out tool to the main palette, press Control/CTRL while you select
the tool from a pop-out.

• To hide a tool, press Control/CTRL while you click that tool. At least one tool
from each pop-out must remain on the main palette. 

• When you quit QuarkXPress, your current tool arrangement is saved in the
XPress Preferences file. The next time you launch QuarkXPress, your Tool
palette will be just as you left it.

44



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 1: The Concepts

The Details: Item and Content Tools

Item and Content Tools

When the Item tool e is selected, you can cut, copy, and paste picture boxes,
lines, text paths, and groups. When the Content tool E is selected, you can
cut, copy, paste, clear, and edit text or pictures.

Features specific to the Item tool e
When the Item tool is selected you can:

• Cut, copy, or paste active items entirely. (This is also possible when any other
tool is selected except the Content tool E.)

• Delete active Bézier points using the Delete/BACKSPACE key.

• Move active items using arrow keys.

• Activate a group by selecting only one of its items.

• Change the line attributes of an active text path. (This is also possible when
any other tool is selected except the Content tool E.)

Features specific to the Content tool E
When the Content tool is selected you can:

• Cut, copy, paste, or clear highlighted text or cut, copy, paste, or clear pictures
in active picture boxes. The boxes themselves are unaffected.

• Edit and apply attributes to existing text or import new text into an active text
box or text path.

I-beam pointer I
When the Content tool is over a selected text box or text path, the I-beam
pointer I displays. Click the I-beam pointer to place the Text Insertion bar i
where you want to import or edit text. You cannot place the Text Insertion bar i
below existing paragraphs. To highlight text, drag the I-beam pointer I over it. 

You can edit highlighted text using the Style menu, the Measurements palette,
keyboard commands, or the Text tab of the Modify dialog box (Item menu).

Text Insertion bar i
When you click the I-beam pointer I in a text box or path, a blinking Text
Insertion bar i displays. This is the text insertion point. If you create a new
text box, the Text Insertion bar i displays automatically at the top of the box.

You can enter text at the text insertion point by typing or choosing Get Text
(File menu). You can delete text preceding this point by pressing Delete/BACK-
SPACE. To reposition the Text Insertion bar i, use the arrow keys on the keyboard
or click with the I-beam pointer I. 
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Picture Mover pointer H
When the Content tool is over an active picture box that contains a picture, the
Picture Mover pointer H displays. To move the picture, drag the Picture Mover
pointer in any direction, or use the arrow keys on the keyboard.

You can edit a picture using the Style menu, the Measurements palette, key-
board commands, or the Picture tab of the Modify dialog box (Item menu).

Features common to the Item tool and the Content tool

You can use either the Item tool e or the Content tool E to:

• Select and manipulate boxes, lines, and text paths.

• Import and apply styles to pictures.

Arrow pointer a
When you select the Item or Content tool, the Arrow pointer a displays. To
select an item, click it with the Arrow pointer; to select multiple items, press
the Shift (w) key while you click them.

Marquee o
With either the Item or Content tool selected, you can access a standard
Marquee pointer o to select multiple items. Begin by pressing the mouse button
outside any item boundaries, then drag the Marquee over multiple items. To add
or remove an item, press the Shift (w) key while you click the item.

Resizing pointer #
When the Item e or Content E tool is over a bounding box handle of an active
item, the Resizing pointer # displays. To enlarge or reduce an item, drag the
handle using the Resizing pointer.

You can scale the contents of a box or text path, while you resize the item itself,
by pressing modifier keys as you drag a handle:

Mac OS
Resize item and scale contents Command

Scale C+drag
Scale and constrain to square bounding box C+w+drag
Scale and maintain proportions C+`+w+drag

Windows
Resize item and scale contents Command

Scale CTRL+drag
Scale and constrain to square bounding box CTRL+SHIFT+drag
Scale and maintain proportions CTRL+ALT+SHIFT+drag
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Mover pointer e
When the Item tool is placed over items, or Bézier items whose bounding box is
displayed, the Mover pointer e displays. To move active items, drag them using
the Mover pointer e. You can also press the Shift (w) key while selecting and
dragging an item to constrain its movement horizontally or vertically. To access
the Mover pointer e when the Content tool is selected, press C/CTRL.

GWhen you drag an item, only its outline displays. To see the item and its
contents, select Show Contents in the Interactive tab of the Application

Preferences dialog box (Edit menu), press the mouse button until the item
flashes, then begin dragging. To see item layering and text reflow as you move an
item, select Live Refresh in the Interactive tab, press the mouse button until the
multi-directional arrow pointer displays, then begin dragging.
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Rulers and Guides

Rulers and guides give you precise control for document layout. To ensure that
items are placed properly, you can “snap” items to guides. To display rulers,
choose View & Show Rulers. To display guides, choose View & Show Guides.
You can choose to display page guides either Behind or In Front of items using
the Guides menu in the General tab of the Document Preferences dialog box
(Edit menu).

Ruler guides

Ruler guides are guides that you create by dragging them off the horizontal and
vertical rulers. 

• If the Measurements palette is displayed when you drag a ruler guide, the
guide’s position is indicated in the X field (for vertical ruler guides) or the
Y field (for horizontal ruler guides). 

• If you release the mouse button when the g pointer is positioned over the
pasteboard, the ruler guide will extend across the pasteboard and all the pages
in the spread. If you release the mouse button when the pointer is positioned
over a document page, the ruler guide is displayed only on that page.

• To reposition a ruler guide, click it, then drag it to a different location using
either the g or the G pointer. You must have the Item tool e selected to click
and drag a guide when the pointer is over an item. To reposition a guide when
the pointer is over an item and the Content tool E is selected, press C/CTRL

while you click the guide and drag. 

• To remove a ruler guide, click it and drag it off the page. To remove ruler
guides from a spread’s pasteboard, scroll the document so that a portion of
the pasteboard is displayed; then press Option/ALT while you click the ruler
adjacent to the pasteboard. To remove ruler guides from a document page,
scroll the document so that a portion of the page is displayed; then press
Option/ALT while you click the ruler adjacent to the document page. Press
Option/ALT and click the horizontal ruler to delete horizontal ruler guides;
or click the vertical ruler to delete vertical ruler guides.

H Specifying preferences for rulers: Menus in the General tab of the
Document Preferences dialog box let you set preferences for rulers. You

can specify ruler measurement units using the Horizontal Measure and Vertical
Measure menus. The Item Coordinates menu lets you specify whether or not
the top ruler is continuous across multiple pages in a spread. Choose Spread to
display a single, continuous ruler across the top of pages in a spread. Choose
Page to repeat the horizontal ruler from 0 for each page in the spread. For exam-
ple, if you have a two page spread of letter size pages, the ruler will start at 0"
and end at 81⁄2" for each page.
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Menus and Dialog Boxes

There are seven basic menus available in QuarkXPress: File, Edit, Style, Item,
Page, View, and Utilities, plus the Window menu on Windows. The menu bar
can also display menus for help, and QuarkXTensions™ such as QuarkImmedia™

and QuarkDispatch™. Each menu contains groups of related commands separated
by lines. Many menu entries can be activated by keyboard shortcuts.

Context-sensitive menus

Menus are context-sensitive so menus or menu items can change according
to the active item, the current situation, or the tool selected.

• All the commands listed under a menu may change. For example, the
Style menu commands change depending on whether text, a picture, or a
line is active.

• An individual menu command may change. For example, the Undo command
in the Edit menu changes to reflect your last action (such as Undo Typing or
Undo Item Deletion).

• The availability of menu entries may change. For example, when a pic-
ture is selected, the Save Text command in the File menu is dimmed and
not available.

• The availability of entire menus may change. For example, the Style menu
entries for text are available only when a text box is active and the Content
tool E is selected.

Checkmark

A checkmark j in a menu indicates one of the following:

• A function has been performed. For example, a checkmark is displayed
next to Flip Vertical in the Style menu when the contents of a box are
flipped vertically.

• A feature is turned on. For example, a checkmark next to Snap to Guides in
the View menu means items in your document will snap to the guides.

• A format from a list has been applied. For example, a checkmark is displayed
in the Font submenu next to the font applied to selected text. When multi-
ple formats have been applied to a selection, checkmarks are displayed next
to formats common to the entire selection only. 

Dialog boxes

Dialog boxes contain related commands that let you specify exactly what you
want to happen. The context-sensitive controls in QuarkXPress dialog boxes
consist of tabs, areas, fields, menus, check boxes, and buttons.
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Tabs and areas
Many dialog boxes provide multiple functions through tabs. By clicking a tab,
you can display different sets of controls. Related commands within a dialog
box or tab are grouped into an “area,” surrounded by a border.

The Blend area of the Box tab in the Modify dialog box lets you specify a custom
blend for a box.

Lists
Some dialog boxes include lists of elements you can select or edit. For example,
the Colors dialog box (Edit menu) displays a list of colors. 
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Fields
A field is a rectangular box for entering a specific value. For example, in the
Text tab of the Modify dialog box (Item menu), you can enter the number of
columns for an active text box in the Columns field. When working with fields,
you can enter measurements in any of the QuarkXPress supported measurement
systems using the following abbreviations: 

Measurement System Abbreviation

inches or inches decimal "
picas p
points pt
millimeters mm
centimeters cm
ciceros c
agates ag

You can perform math in fields using these operators:

Function Operator

addition +
subtraction –
multiplication *
division /

For example, to double the width of a box, you can multiply the width by 2 by
entering *2 to the right of the current value. You can even perform multiple
operations — such as dividing a value by 4, then adding 2.

Menus (pop-up/drop-down) 
These are small menus within a dialog box or palette (usually called “pop-up
menus” on Mac OS and “drop-down lists” on Windows). A menu like this 
contains a list of options. A menu like this contains an editable field in
addition to a list of options. You can enter a value (such as a percentage) or a word
(like a font name) in the field, rather than choosing an option from the list.

Check boxes
A check box lets you turn options on and off . 

Buttons (radio/option) 
A button like this % lets you select from mutually exclusive options.
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Buttons
A button like this performs an action. If the button has a heavy
border , you can press Return/ENTERr rather than clicking the button
with the mouse. A button may also include a menu that lets you choose
a type of action. For example, the New button in the Style Sheets dialog box
(Edit menu) lets you create either a character style sheet or a paragraph style
sheet. Many dialog boxes in QuarkXPress include an Apply button so you can
preview your changes before closing the dialog box. 

G In certain dialog boxes such as Paragraph Attributes (Style menu) and
Character Attributes (Style menu), you can press Option/ALT the first
time you click Apply to continually preview changes as you make them.

H Using modifier keys with menus: The function of a menu command
may change slightly when you press a modifier key as you select the

menu. On Mac OS for example, if you press Option while you choose the Item
menu, the Send to Back command changes to Send Backward. 

H Selecting elements from a list: You can navigate through lists using the
up and down arrow keys. Depending on the type of list, you may be able

to multiple-select elements. To select a group of continuous elements, click the
first element then press the Shift (w) key while clicking the last element in the
range. To select a group of noncontinuous elements, press C/CTRL while clicking
each element.

H Specifying units of measure: You only need to specify an abbreviation
for units of measure when you are not using the default measurement

system. The default measurement system is specified in the Horizontal Measure
and Vertical Measure menus in the General tab of the Document Preferences
dialog box (Edit menu).

H Performing math in fields: When performing calculations in fields,
QuarkXPress performs multiplication and division first, followed by

subtraction and addition, from left to right. You cannot use parentheses when
performing math in fields. 
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Measurements Palette

The Measurements palette lets you quickly edit several commonly used item
specifications. Options on the Measurements palette change to reflect the
currently selected tool or item. The left side of the palette indicates an item’s
position; the right side indicates an item’s content.

Overview

You can edit any of the values in the Measurements palette. Changes made
to values on the left side of the palette are applied when you exit the palette;
changes made to numerical values on the right side of the palette are applied
when you move to a different field or exit the palette. Clicking a button or
choosing an item from a menu on the right side of the Measurements palette
applies the change immediately.

Measurements displayed in the Measurements palette are updated when you
create, move, resize, or modify items, create or move guides, or reposition the
ruler origin.

Measurements palette for text boxes

Item information
When a text box is selected, the left side of the Measurements palette lets
you view and edit the text box item information. 

• The X and Y fields indicate the horizontal and vertical locations of the origin
(upper left corner) of the text box.

• The W and H fields indicate the width and height of the text box.

• The r field indicates the text box’s angle of rotation.

• The Cols field indicates the number of columns in the text box.

Content information
When the Content tool E is selected, the right side of the Measurements
palette lets you edit the contents of the text box.

• The ( button lets you flip the contents of the text box along a horizontal axis.

• The ) button lets you flip the contents of the text box along a vertical axis.

• The n field indicates paragraph leading. Enter a value in the field or click the
arrows to adjust leading.
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• The N field indicates kerning when the Text Insertion bar i is between two
characters and indicates tracking when a block of text is highlighted. Enter a
value in the field or click the arrows to adjust kerning and tracking.

• The {, }, [, $, ] buttons indicate left, centered, right, justified, and forced
justified alignment of selected paragraphs.

• The Font menu < indicates the selected font. To change the font, choose a
font from the menu or enter the name of the font in the field.

• The Size menu < indicates the size of the selected font. To change the font
size, choose a size from the menu or enter a value in the field.

• The P, B, I, U, W, ?, O, S, K, H, +, _, and M buttons indicate plain, bold,
italics, underline, word underline, strike thru, outline, shadow, all caps, small
caps, superscript, subscript, and superior type styles, respectively. Multiple
type styles may be applied to a single character or group of characters.

Measurements palette for picture boxes

Item information
When a picture box is selected in the document window, the left side of the
Measurements palette lets you edit the picture box item information.

• The X and Y fields indicate the location of the origin (upper left corner) of
the picture box.

• The W and H fields indicate the width and height of the picture box.

• The r field indicates the picture box’s angle of rotation.

• The = field indicates the radii of the corners of the picture box.

Content information
When the Content tool E is selected, the right side of the Measurements
palette lets you edit the contents of the picture box.

• The ( button lets you flip the contents of the picture box along a
horizontal axis.

• The ) button lets you flip the contents of the picture box along a vertical axis.

• The X% and Y% fields indicate the horizontal and vertical scaling of the
contents of the picture box.
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• The N and n fields indicate the horizontal and vertical offsets of the contents
of the picture box from the picture box’s origin (upper left corner).

• The r field indicates the angle of rotation of the contents of the picture box.

• The S field indicates the skew (slant) of the contents of the picture box.

Measurements palette for lines

When lines are active, fields displayed on the left side of the Measurements
palette vary according to the line description method selected in the Mode
menu. Line description methods let you choose whether to describe the selected
line by its Endpoints; its First Point, length, and angle; its Last Point, length,
and angle; or by its Midpoint, length, and angle. 

Fields on the right side of the Measurements palette indicate the following
line information:

• The W field indicates the width of a selected line.

• The left menu indicates the line’s style.

• The right menu indicates the line’s arrowheads.

Fields on the left side of the palette vary (according to Mode) as follows:

Endpoints

• The X1 and Y1 fields indicate the horizontal and vertical coordinates of the
first endpoint of the line.

• The X2 and Y2 fields indicate the horizontal and vertical coordinates of the
last endpoint of the line.

First Point

• The X1 and Y1 fields indicate the horizontal and vertical coordinates of the
first point created for the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.
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Midpoint

• The XC and YC fields indicate the horizontal and vertical coordinates of the
midpoint (middle) of the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.

Last Point

• The X2 and Y2 fields indicate the horizontal and vertical coordinates of the
last point created for the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.

Measurements palette for groups and multiple-selected items

When groups of items or multiple items are selected, the Measurements palette
lets you edit the origin, dimensions, and angle of the group of items.

• The X and Y fields indicate the location of the origin (upper left corner) of
the bounding box containing the group of items.

• The W and H fields indicate the width and height of the bounding box
containing the group of items.

• The r field indicates the angle of rotation of the group of items. When an
item is rotated with a group of items, it is rotated relative to the center of the
bounding box enclosing the group, not to its own origin (upper left corner).
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Measurements palette for editing Bézier items

When a point, line segment, or curve handle on a Bézier shape is selected, the
Measurements palette lets you edit the origin, dimensions, and angle of the
item, as well as the type of point or line segment in the shape. You can also
enter values to manipulate point position and curve handle angle and length.

• The X and Y fields indicate the horizontal and vertical locations of the origin
(upper left corner) of the Bézier item’s bounding box.

• The W and H fields indicate the width and height of the Bézier item.

• The r field indicates the angle of rotation of the Bézier item.

• The Symmetrical Point button † lets you convert a point into a symmetrical
point for a Bézier item.

• The Smooth Point button ¥ lets you convert a point into a smooth point for
a Bézier item.

• The Corner Point button ® lets you convert a point into a corner point for
a Bézier item.

• The Straight Segment button œ lets you convert a curved line segment to a
straight line segment for a Bézier item.

• The Curved Segment button ∑ lets you convert a straight line segment to a
curved line segment for a Bézier item.

• The XP and YP fields indicate the horizontal and vertical location of the
active point.

• The Diamond Curve Handle Angle field r indicates the angle of the
diamond-shaped curve handle in relation to the active point.

• The Diamond Curve Handle Distance field „ indicates the distance of the
diamond-shaped curve handle from the active point.

• The Square Curve Handle Angle field r indicates the angle of the square-
shaped curve handle in relation to the active point.

• The Square Curve Handle Distance field Œ indicates the distance of the square-
shaped curve handle from the active point.

H Accessing fields in the Measurements palette: To access fields in the
Measurements palette, click them. To access the first field in the palette,

press C+Option+M (Mac OS) or CTRL+ALT+M (Windows). Press Tab to highlight
the next field, or press Shift+Tab to highlight the previous field. Click the docu-
ment, or press Return/ENTERr to apply changes made in the Measurements
palette. On Mac OS, press C+period (.) to exit the palette without applying
changes. On Windows, press ESC to exit the palette without applying changes.
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H Using the Measurements palette with anchored text boxes: When an
anchored text box is active, the Measurements palette indicates whether

the text box aligns with the ascent 6 or baseline 5 of the associated line of
text. Click the ascent 6 or baseline 5 buttons to change the alignment of an
anchored text box. When the Content tool E is selected, the Measurements
palette displays the same content controls for anchored text boxes as those for
nonanchored text boxes. The X, Y, and r fields are not available for
anchored text boxes.

H Using the Measurements palette with anchored picture boxes: When an
anchored picture box is active, the Measurements palette indicates whether

the picture box aligns with the ascent 6 or the baseline 5 of the associated line
of text. Click the ascent 6 or baseline 5 buttons to change the alignment of the
anchored picture box. When the Content tool E is selected, the Measurements
palette displays the same content controls for anchored picture boxes as those for
nonanchored picture boxes. The X, Y, r, and = fields are not available for
anchored picture boxes.
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2
Text Fundamentals
What’s Ahead

You can write text directly in QuarkXPress using its built-in word
processing capabilities. Or, if you prefer using a word processing pro-
gram, you can import text into a QuarkXPress document. Regardless
of where the text originates, you can use QuarkXPress to edit all the
text in your publications.

You’ll start this lesson by creating a new document into which you’ll
import existing text, then you’ll add text directly. You’ll also make
formatting changes to the text you import and create. To see the fin-
ished document, open “Color Text Final.qxt” in the “Lesson 2” folder
inside the “Module 1” folder.
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Creating a New Document

Using QuarkXPress, you can create almost any type of black-and-white or full-
color document ranging from 1" ´ 1" to 48" ´ 48". In this task you’ll create a
new US letter-sized document for the “Color” article.

J Keyboard Commands for Mac OS:

New Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+N

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+S

J Keyboard Commands for Windows:

New Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+N

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+S

.1 If necessary, launch QuarkXPress: If QuarkXPress isn’t running, locate
the QuarkXPress icon and double-click it.
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.2 Open the New Document dialog box: Choose File & New & Document.

The New Document dialog box lets you define page specifications and create
new documents.

.3 Select the size and orientation of the page: In the Page area, choose
US Letter from the Size menu and select vertical (portrait) Orientation.

.4 Specify a single-column text box: Make sure you have these settings in
the Column Guides area:

Field Value

Columns 1
Gutter Width 0.167"

.5 Specify page margins: Make sure you have these settings in the Margin
Guides area:

Field Value

Top 0.75"
Bottom 0.75"
Left 0.75"
Right 0.75"
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.6 Specify single pages instead of left and right-facing pages: Uncheck
Facing Pages if it’s checked.

.7 Create an automatic text box: Make sure Automatic Text Box is
checked, then click OK.

.8 Change the document view: Choose View & Fit in Window.

A dotted rectangle in the center of the page indicates the automatic text box.

.9 Save the document in the Student Files folder: Choose File & Save as
to display the Save as dialog box, then select the Student Files folder.

Enter a descriptive name like “My Color Text Doc.qxd.” (Use the three-character
extension “.qxd” in the name.) 

Verify that the Type is Document and the Version is 4.0. To create a preview
of the file (Mac OS), check Include Preview, then click Save.
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H Setting up new documents: The values you enter in the New Document
dialog box are used as defaults the next time you create a new document.

H Default master page: Every QuarkXPress document contains a master
page by default. A master page is a nonprinting page used to automati-

cally format document pages. The default master page formatting is based on
settings in the New Document dialog box. 

H Automatic text boxes: When you check Automatic Text Box,
QuarkXPress places an automatic text box on the first page and the default

master page of a document. The size of the automatic text box is determined by
the values in the Margin Guides area. If you specify more than one column in
the Columns field, the automatic text box is divided into linked columns. If you
don’t check Automatic Text Box, QuarkXPress still draws guides on document
pages based on the values in the Margin Guides and Column Guides areas, but
doesn’t place a text box on the pages. 
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Importing Text

You enter text or import text files into active (selected) text boxes. Characters are
entered at the text insertion point indicated by the blinking i icon. QuarkXPress
includes XTensions filters for the XPress Tags format and for leading third-party
word processing programs so you can import and export text in a variety of file
formats. In this task you’ll import a text file that was saved in the XPress Tags
format, then you’ll change its attributes.

J Keyboard Commands for Mac OS:

Get Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+E

Select All  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+A

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+1

Bold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+B

Italic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+I

J Keyboard Commands for Windows:

Get Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+E

Select All  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+A

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+1

Bold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+B

Italic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+I

.1 Select the automatic text box: Using the Content tool E, click the text
box in the center of the page. The text insertion point i appears in the

upper left corner of the text box.
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.2 Open the Get Text dialog box: Choose File & Get Text.

The Get Text dialog box lists ASCII files and word processing files for which an
import/export filter is running. It also lists a selected file’s format and size.

.3 Import a text file: Open the “Module 1” folder, then open the “Lesson 2”
folder. Select the “Color.txt” file.

Check Convert Quotes to convert double hyphens (--) to em dashes (—), and
foot or inch marks (' ") to typesetter’s curly quotation marks (‘’ “”).

Check Include Style Sheets to convert XPress Tags code in the imported ASCII
text to actual text formatting. 

Click Open. Text is imported into the text box and a second page is added to
the document.

.4 Select the entire range of text: Scroll up to see page 1. Make sure the
text box is still active. Choose Edit & Select All. 

.5 Change the font and point size of the text: Choose Style & Font &
Helvetica or Arial. Choose Style & Size & 9 pt. The text reflows to fit

on page 1.
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.6 Display the document at actual size: Choose View & Actual Size.

.7 Change the attributes of a subhead: If necessary, scroll up to highlight
just the subhead “Creating color: Subtractive color versus additive color.”

Using the Measurements palette, enter Times or Times New Roman in the
Font field, or choose Times or Times New Roman from the Font menu <.

Times has been chosen in the Font field.

Enter 10 in the Size field or choose 10 pt from the Size menu <.

The 10 point size has been chosen in the Size field.

Click the Bold button B and the Italic button I, then press Return/ENTERr.

The Bold button B and the Italic button I are highlighted.

67



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 2: Text Fundamentals

The Steps: Importing Text

.8 Change the attributes of remaining subheads: If necessary, scroll down
to highlight the subhead “Subtractive color and printing.”

Using the Measurements palette, change the font to Times (or Times New
Roman), the point size to 10, and the style to bold and italic, then press
Return/ENTERr. Scroll down and highlight the subhead “Additive color and
color video monitors.”

Using the Measurements palette, change the font to Times (or Times New
Roman), the point size to 10, and the style to bold and italic, then press
Return/ENTERr.

The body text in the document has been formatted with Helvetica 9 point and the
subheads are Times bold italic 10 point.
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H XPress Tags: XPress Tags is a file format for saving text files with
QuarkXPress character-formatting information.

H Importing text: If imported text doesn’t fit in an automatic text box and
Auto Page Insertion is enabled (General tab, Document Preferences

dialog box), pages are automatically added to a document. If the text box is
not an automatic text box or Auto Page Insertion is not enabled, the overflow
symbol t displays.

H Changing font size using keyboard commands: On Mac OS, you
can increase the font size of selected text to the next larger preset size

by pressing C+Shift+>. To increase the size in 1-point increments, press
C+Option+Shift+>. To decrease the font size to the next smaller preset size,
press C+Shift+<. To decrease the font size of selected text in 1-point incre-
ments, press C+Option+Shift+<. On Windows, you can increase the font
size of selected text to the next larger preset size by pressing CTRL+SHIFT+>.
To increase in 1-point increments, press CTRL+ALT+SHIFT+>. To decrease the
font size to the next smaller preset size, press CTRL+SHIFT+<. To decrease in
1-point increments, press CTRL+ALT+SHIFT+<.
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Creating Text Boxes

Boxes are items that can contain colors, blends, text, or pictures. They are the
framework on which QuarkXPress documents are built because their boundaries
give colors, blends, text, and pictures a specific shape, size, and placement on a
page. In this task you’ll create a text box.

.1 Deselect the automatic text box: Scroll to the top of page 1. Click outside
the boundaries of the existing text box.

.2 Create a text box: Click the Rectangle Text Box tool T to select it. In the
upper left corner of page 1, click and drag diagonally to make a text box

approximately 7" wide and 3.75" high. (Don’t worry about exact size or place-
ment now, you’ll set those specifications next.) 

The existing text reflows, or “runs around” the new text box.

A rectangular text box appears on the page and the existing text reflows below it.
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Enter these settings in the Measurements palette to precisely size and position
the text box:

Field Setting

X (horizontal position of upper left corner of box) 0.75"
Y (vertical position of upper left corner of box) 0.75"
W (width of box) 7"
H (height of box) 3.75"

H Resizing and positioning text boxes: You can resize an active text box
manually using the Resizing pointer f and position it manually using

the Item tool e. To specify the location of the upper left corner of a text box
numerically, enter values in the X and Y fields of the Measurements palette, or
in the Origin Across and Origin Down fields in the Box tab of the Modify
dialog box (Item menu). To specify dimensions for a text box numerically, enter
values in the W and H fields of the Measurements palette, or in the Width and
Height fields in the Box tab of the Modify dialog box (Item menu).
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Entering and Formatting Text

To enter text in a text box, the text box must be active and the Content tool E
must be selected. In this task you’ll enter text and format it.

J Keyboard Commands for Mac OS:

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+M

J Keyboard Commands for Windows:

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+M

.1 Select the Content tool E: If it isn’t selected, click the Content tool E.

.2 Select a text box: If it isn’t active, click the text box you created in the
previous task. The text insertion point i appears in the upper left corner

of the text box.

.3 Enter text in the box: Type color in all lowercase characters.

.4 Change the font and point size of the text: Double-click to highlight
the word “color.”

Using the Measurements palette, enter Times or Times New Roman in the
Font field or choose the font from the Font menu <.

Times has been entered in the Fonts field.

Enter 150 in the Size field, then press Return/ENTERr.

A 150 point size has been entered in the Size field.

.5 Change the horizontal text alignment: Make sure the word “color” is
still highlighted.
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Click the centered alignment button } in the Measurements palette.

The alignment buttons in the Measurements palette let you specify left, centered,
right, justified, and forced justified alignment for selected paragraphs.

.6 Change the vertical text alignment: Make sure the text box is still
active. Choose Item & Modify to open the Modify dialog box.

Click the Text tab.

Choose Type & Centered from the Vertical Alignment area, then click OK.

The Text tab of the Modify dialog box is available when text boxes are active.
The controls in the Text tab let you specify a number of text box settings, includ-
ing Vertical Alignment.
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H Highlighting the font field of the Measurements palette: To quickly
highlight the font field of the Measurements palette on Mac OS, press

C+Option+Shift+M; on Windows, press CTRL+ALT+SHIFT+M.

H Using the Apply button: Many dialog boxes in QuarkXPress include
an Apply button so you can preview your changes before closing the

dialog box. In certain dialog boxes such as the Paragraph Attributes dialog
box (Style menu) and the Character Attributes dialog box (Style menu),
you can press Option/ALT the first time you click Apply, to continually pre-
view changes as you make them.
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Copying and Pasting Items

Copying, cutting, or pasting items or contents is useful when moving them
within a document, or from one document to another. To copy, cut, or paste
items (boxes, lines) you must select the Item tool e. To copy, cut, or paste
contents (pictures, text) you must select the Content tool E. In this task
you’ll copy a text box from the first page of a document and paste it on the
second page. 

J Keyboard Commands for Mac OS:

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+V

J Keyboard Commands for Windows:

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+V

.1 Select the Item tool e: If it isn’t selected, click the Item tool e.

.2 Copy the text box: Make sure the text box containing the word “color”
is still active. Choose Edit & Copy.

.3 Paste the text box on the second page of the document: Scroll to page 2
or choose Page & Next. Choose Edit & Paste.
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.4 Move the text box into position on the page: Using the Item tool e
to drag the text box, align its upper left corner with the Margin Guides

in the upper left corner of the page. The existing text reflows below the new
text box. 

The text box aligns with the guides and the existing text reflows below it.
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Applying Character Attributes

You can change character attributes such as the font, size, and type style of
highlighted text using Style menu commands, the Measurements palette, or
the Character Attributes dialog box. In this task you’ll apply character attrib-
utes to text using the Character Attributes dialog box.

J Keyboard Commands for Mac OS:

Character Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+D

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+S

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+W

J Keyboard Commands for Windows:

Character Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+D

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+S

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+F4

.1 Select the text: Using the Content tool E, double-click to highlight
the word “color” in the text box you pasted on page 2.
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.2 Open the Character Attributes dialog box: Choose Style & Character.

The Character Attributes dialog box lets you edit all the Style menu character
attributes at one time.

.3 Change the attributes of the text: Enter Helvetica or Arial in the
Font field or choose the font from the Font menu <.

Enter 56 in the Size field.

Enter 50 in the Shade field or choose 50% from the Shade menu <.

Choose Vertical from the Scale menu and enter 250 in the Scale field to
increase the height of the text characters.

Enter 50 in the Track Amount field to increase the space between text
characters. Click OK.

.4 Change the text: Make sure the text is still highlighted. Enter MODELS
in all caps.
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.5 Modify a single character: Highlight the letter “L.” Click the Italic
button I on the Measurements palette.

The second page of your document should look something like this.

.6 Close and save the document: Choose File & Close. If you haven’t
recently saved your document, a dialog box asks you to save it. Click Yes.

H Using character style sheets: You can apply a number of character attrib-
utes to text quickly and easily using character style sheets. A character style

sheet is a saved set of character attributes — for example, a specific font, color,
and size in bold and italic — that can be applied to a single text character or a
range of characters in a single step. To create a character style sheet, choose
Edit & Style Sheets & New & Character.
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Checkpoint

Confirm your new skills — then try them out. If you have any questions, ask
your instructor or consult “The Details” section of this lesson.

How are you doing?

Make sure you can:

• Create a new document with an Automatic Text Box

• Create text boxes using the Rectangle Text Box tool T

• Import text and enter text using the keyboard

• Format text

• Copy and paste items

• Apply text attributes

On your own

Experiment with new documents or open some of the other lesson files.
Try the following:

• Create a few more text boxes.

• Import text or enter your own text.

• Change the attributes of some text using the Measurements palette or the
Character Attributes dialog box.

• Copy a text box and paste it in a new location — paste one text box on top
of another and see how the text reflows.

G The lesson files are all templates, which means you can open copies of
them without affecting the original files.
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New Documents

You can create a new document any time, as long as you have fewer than
25 files open. When you create a new document, you can specify its page
size and margin positions, and you can choose whether the document will
consist of single pages or of spreads with left-facing and right-facing pages.
You also have the option of creating columns and text boxes automatically
on your document pages. 

.1 To create a new document, choose File & New & Document.

.2 To specify a standard page size, choose an option from the Size menu.
To create a custom-sized page, enter dimensions in the Width and

Height fields. 

.3 Choose either vertical or horizontal page orientation. On Mac OS, do this
by clicking one of the Orientation icons ™ £. On Windows, click the

Portrait or Landscape button.

.4 To specify the position of the margin guides, enter values in the fields in
the Margin Guides area.

.5 To specify that the document contains both left-facing and right-facing
pages check Facing Pages.

.6 To specify the number of columns on document pages and the spacing
between them, enter values in the Columns and Gutter Width fields.

.7 To place an automatic text box on the first page of the document and on
the default master page, check Automatic Text Box. 

The size of an automatic text box is determined by the values entered in the
Margin Guides area. If more than one column is specified in the Columns field,
the automatic text box is divided into linked columns automatically. If you don’t
check Automatic Text Box, QuarkXPress still draws guides on document pages
that reflect the values in the Margin Guides and Column Guides areas. 

.8 Click OK to create a new document based on your specifications.

G QuarkXPress remembers the values in the New Document dialog box and
uses them as defaults the next time you create a new document.
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Text

With the word processing capabilities built into QuarkXPress, you can create text
for your publications without using another program. Or, QuarkXPress lets you
import and export ASCII text and ASCII text with XPress Tags formatting codes.
QuarkXPress also includes import/export filters for the leading third-party word
processors like Microsoft Word and WordPerfect. To use the import/export filters,
place them in your XTension folder and enable them with the XTensions
Manager dialog box (Utilities menu). 

J Keyboard Commands for Mac OS:

Select All the text in a story  . . . . . . . . . . . . . . . . . . . . .C+A

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+V

Cut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+X

Previous character . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Next character  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

Previous line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Next line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .0

Previous word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+7

Next word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+8

Top of paragraph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+9

Top of next paragraph  . . . . . . . . . . . . . . . . . . . . . . . . .C+0

Beginning of line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+7

End of line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+8

Beginning of story  . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+9

End of story  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+0

Select previous word . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+7

Select next word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+8

Select to top of paragraph  . . . . . . . . . . . . . . . . . . . . . .C+w+9

Select to top of next paragraph  . . . . . . . . . . . . . . . . . .C+w+0

Select to line beginning  . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+7

Select to end of line  . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+8

Select to story beginning  . . . . . . . . . . . . . . . . . . . . . . .C+`+w+9

Select to end of story  . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+0
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J Keyboard Commands for Windows:

Select All the text in a story  . . . . . . . . . . . . . . . . . . . . .CTRL+A

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+V

Cut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+X

Previous character . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Next character  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

Previous line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Next line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .0

Previous word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+7

Next word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+8

Top of paragraph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+9

Top of next paragraph  . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0

Beginning of line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+7 or HOME

End of line  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+8 or END

Beginning of story  . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+9 or
CTRL+HOME

End of story  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+0 or CTRL+END

Select previous word . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+7

Select next word  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+8

Select to top of paragraph  . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+9

Select to top of next paragraph  . . . . . . . . . . . . . . . . . .CTRL+SHIFT+0

Select to line beginning  . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+7

Select to end of line  . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+8

Select to story beginning  . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+9

Select to end of story  . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+0

Entering Text

In QuarkXPress you enter and import text into active text boxes or text paths.

• To enter text into a text box or text path, select the Content tool E. Click the
text box or text path to activate it. The blinking text insertion point i indicates
where text is entered.

• To move the text insertion point i, click the mouse when the Text Insertion
bar I is at the desired location. You can establish a new text insertion point i
only within text or at the end of the last paragraph in the text box.
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• To highlight a range of text using the mouse, click the Text Insertion bar I at
the desired location, then drag over the text and release the mouse.

Importing text

If you are importing text from a word processor or in XPress Tags format, make
sure the appropriate import filter is running. To import text:

.1 Select the Content tool E. 

.2 Click the Text Insertion bar I in a text box or text path at the point where
you want text to be inserted. To replace a range of text with imported text,

highlight the range you want to replace.

.3 Choose File & Get Text to open the Get Text dialog box. Use the controls
in the dialog box to locate the file you want to import.

.4 Select the file in the scroll list. When you select a file, the Type and Size
fields indicate its format and size.

.5 Check Convert Quotes to convert double hyphens (--) to em dashes (––)
and foot or inch marks to typesetter’s quotation marks. Foot and inch

marks (' ") are converted to the format specified in the Quotes menu of the
Interactive tab (Application Preferences dialog box).

.6 Check Include Style Sheets to import style sheets from Microsoft Word
or WordPerfect files, or to convert XPress Tags code to text formatting. 

.7 Click Open. 

Exporting text

Using QuarkXPress, you can save text in file formats that can be opened by word
processing programs and other applications. To export text:

.1 Make sure you have the appropriate export filter running.

.2 To save all the text contained in a text box or a chain of linked boxes,
activate the text box (or any text box in the chain). To save only some of

the text, highlight the range of text you want to save. 

.3 Choose File & Save Text to open the Save Text dialog box. If you high-
lighted a range of text, Selected Text is active. If no text is highlighted,

Entire Story is active.
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.4 Choose a file format from the Format menu. The menu only lists ASCII
Text (plus RTF format on Windows) and file formats for which an

import/export filter is running.

.5 Enter a name for the export file in the Save text as field.

.6 Use the controls to specify a location for the export file. 

.7 Click Save.

Copying, cutting and pasting text

Copying or cutting text, and pasting it, is useful when editing your document.
To copy, or cut, and paste:

• Select the Content tool E. Highlight the appropriate text, then choose Edit &
Copy or Edit & Cut. The text will be placed on the Clipboard.

• To paste text from the Clipboard into your document, select the Content
tool E. Place the text insertion point i where you want the pasted text to
begin. Choose Edit & Paste.

Editing with Drag and Drop Text

Drag and Drop Text lets you highlight text and move it with the mouse. You
can drag and drop text only within a text chain, not between unlinked text
boxes. To Drag and Drop Text:

• Open the Application Preferences dialog box (Edit menu); then click the
Interactive tab. Check Drag and Drop Text, then click OK.

• Highlight the text you want to move or copy.

• To move highlighted text, click within the highlighted range of text, drag
the pointer to a new location, then release the mouse to drop the text
into place.

• To copy and move highlighted text, press the Shift (w) key while clicking
within the highlighted range, drag the pointer to a new location, then
release the mouse to drop the copied text. 
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Boxes

QuarkXPress uses three different types of boxes — text boxes, picture boxes,
and “contentless” boxes. You can enter, import, and paste text into active text
boxes, and import or paste pictures into active picture boxes. Contentless boxes
do not support text or pictures, but like text boxes and picture boxes, they can
contain colors, shades, blends, and frames. 

Creating boxes

Select a box tool from the Tool palette, move the Crosshair pointer c to any
position on the page; then click and drag (or click and create points with
Bézier box tools) to draw the box. To keep an item creation tool selected,
press Option/ALT when selecting the tool.

Moving boxes

You can move active boxes by dragging them with the Item tool e. You can
also enter precise values in the Box tab of the Modify dialog box (Item menu)
or the Measurements palette. You can view box position coordinates in the
Measurements palette as you move boxes. You can move boxes within the same
page, across page boundaries, or onto the pasteboard. You can also drag boxes to
other open QuarkXPress documents or libraries. To move boxes you can:

• Select the Item tool e, then drag a box to a new location.

• Open the Modify dialog box (Item menu); then click the Box tab. To move
a box horizontally, enter a value in the Origin Across field. To move a box
vertically, enter a value in the Origin Down field. Click OK.

• Enter a value in the X field of the Measurements palette to move a box
horizontally. To move a box vertically enter a value in the Y field. Press
Return/ENTERr.

• Use the following keyboard commands:

Automatic moving features Command

Nudge boxes in 1-point increments arrow keys
Nudge boxes in .1-point increments Option/ALT and arrow keys

GWhen using the arrow keys, if the Content tool E is selected and a pic-
ture box is active, the box contents (picture) will move instead of the box.

If a text box is active, the cursor will move.
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H Creating circle or square boxes: To constrain an oval box to a circle,
select either of the Oval Box tools Î O and press the Shift (w) key while

you drag. To constrain a rectangle box to a square, select either of the Rectangle
Box tools T p and press the Shift (w) key while you drag.

H Viewing contents while moving boxes: If you click and pause slightly
before you drag a box with the Item tool e, you can view its contents

(and not just its outline). This can be helpful when you need to reposition an
item according to its contents. The delay time is determined in the Interactive
tab of the Application Preferences dialog box (Edit menu). 
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Cut, Copy, and Paste

The Cut, Copy, and Paste commands let you edit items or contents, depending
on whether the Item tool e or the Content tool E is selected.

• When the Item tool e is selected, the Cut command removes active items
(boxes, lines, text paths, etc.) and their contents and places them on the
Clipboard. When the Content tool E is selected, the Cut command removes
highlighted text or an active picture and places it on the Clipboard. 

• When the Item tool e is selected, the Copy command places a copy of active
items and their contents on the Clipboard. When the Content tool E is
selected, the Copy command places a copy of highlighted text or an active
picture on the Clipboard. The Copy command does not remove elements
from the document.

• The ability to paste depends on the selected tool, the contents of the
Clipboard, and the active item in the document. The Paste command places
the Clipboard’s contents into a document or into an item as shown in the
table below: 

Tool Clipboard contents Active item Paste location

e boxes/lines/text paths any center of document window
E text text box/path text insertion point i
E picture picture box upper left corner of box
E boxes/lines/text paths none center of document window
E box or no-content line text box/path anchored at text insertion point i

GIf you paste text in a box containing highlighted text, the highlighted
text is replaced. If you paste a picture in a box containing a picture, the

picture is replaced. 

H Cutting and copying items when the Content tool E is active:
On Mac OS, you can cut an item when the Content tool E is active by

pressing C+X. To copy an item when the Content tool E is active, press C+C.
On Windows, you can cut an item when the Content tool E is active by press-
ing CTRL+X. To copy an item when the Content tool E is active, press CTRL+C.
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3
Picture Fundamentals
What’s Ahead

Whether you use photographs, illustrations, or charts, you can add inter-
est and provide information that words alone can’t provide by importing
pictures into your QuarkXPress documents. (QuarkXPress uses the generic
term “picture” for any imported graphic.) You can change the color of a
picture, enlarge or reduce its size, alter its angle or position, and change its
contrast. You can even remove portions of a picture’s background using
QuarkXPress clipping paths.

In this lesson you’ll create picture boxes, import pictures, and modify
them. To see the finished document, open “Color Pictures Final.qxt” in
the “Lesson 3” folder inside the “Module 1” folder.
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Creating Picture Boxes

Before you can add a picture to your document, you must create a picture
box to contain it. In this task you’ll create a picture box in an existing
QuarkXPress document.

J Keyboard Commands for Mac OS:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+S

J Keyboard Commands for Windows:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+S

.1 If necessary, launch QuarkXPress: If QuarkXPress isn’t running, locate
the QuarkXPress icon and double-click it.

.2 Open an existing document: Choose File & Open to display the
Open dialog box.

Open the “Module 1” folder, then open the “Lesson 3” folder. Select the
“Color Pictures.qxt” template and click Open. 
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.3 Change the document view: Choose View & Fit in Window.

The first page of the existing document appears in the document window.

.4 Save the document in the Student Files folder: Choose File & Save as
to display the Save as dialog box; then select the Student Files folder.

Enter a descriptive name like “My Color Pictures Doc.qxd.” (Use the three-
character extension “.qxd” in the name.) 

Verify that the Type is Document and the Version is 4.0. To create a preview
of the file (Mac OS), check Include Preview, then click Save.
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.5 Create a picture box: Select the Rectangle Picture Box tool p. Beginning
at the upper left corner of the page, drag to make a picture box approxi-

mately 2.75" wide and 11" high. (Don’t worry about exact size or placement now,
you’ll set those specifications next.) 

The existing text reflows, or “runs around” the picture box.

By default, text runs around items placed in front of it. This is also called “text wrap.”
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Enter these settings in the Measurements palette, then press Return/ENTERr

to precisely size and position the picture box:

Field Setting

X (horizontal position of upper left corner of box) 0"
Y (vertical position of upper left corner of box) 0"
W (width of box) 2.75"
H (height of box) 11"

H Resizing and positioning picture boxes: You can resize an active picture
box manually using the Resizing pointer f and position it manually using

the Item tool e. To specify the location of the upper left corner of a picture box
numerically, you can enter values in the X and Y fields of the Measurements
palette, or in the Origin Across and Origin Down fields in the Box tab of the
Modify dialog box (Item menu). To specify dimensions for a picture box numer-
ically, enter values in the W and H fields of the Measurements palette, or in the
Width and Height fields in the Box tab of the Modify dialog box (Item menu).
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Running Text Around Items

The Runaround command lets you control whether text runs behind, around,
or within items “stacked” in front of it. You can also create custom runaround
paths and manually modify them. In this task you’ll specify runaround for the
picture box you created in the previous task.

J Keyboard Commands for Mac OS:

Runaround  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+T

J Keyboard Commands for Windows:

Runaround  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+T

.1 Display the Runaround tab of the Modify dialog box: Make sure the
picture box you created is still active. Choose Item & Runaround.

Controls in the Runaround tab vary depending on the type of item that is active.
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.2 Specify a Runaround value: Enter 18 in the Right field; then click OK
to place the text 18 points to the right of the picture box.

The text reflects the new Runaround setting.

H Stacking order and runarounds: Stacking order refers to an item’s posi-
tion relative to items in front or behind it. The default stacking order is

from back to front, in the order that items are created. You can change the stack-
ing order of items using the Send to Back or Bring to Front commands (Item
menu). Runaround refers to the way in which text flows with respect to items
stacked in front of it. You can control text flow using the Runaround tab of the
Modify dialog box (Item menu), or the Run Text Around All Sides check box
in the Text tab of the Modify dialog box. The Runaround tab is not available
for groups, multiple-selected items, or anchored items.
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Importing Pictures

QuarkXPress lets you import pictures created with paint, draw, illustration, and
scanning programs in a variety of file formats such as TIFF, JPEG, or EPS. In this
task you’ll import a TIFF file into an active picture box.

J Keyboard Commands for Mac OS:

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+E

Center Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+M

Fit in Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+F

Fit in Box (w/aspect ratio)  . . . . . . . . . . . . . . . . . . . . . .C+`+w+F

J Keyboard Commands for Windows:

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+E

Center Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+M

Fit in Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+F

Fit in Box (w/aspect ratio)  . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+F

.1 Open the Get Picture dialog box: Choose File & Get Picture. (Get
Picture replaces Get Text in the File menu when a picture box is active.) 

G To import a TIFF picture with LZW compression or a JPEG picture, make
sure the LZW import and/or JPEG import XTensions are active.

The Get Picture dialog box lists the Color Depth, Dimensions, Resolution, Type

of file, File Size, and Date of creation for a selected picture. It can also include a
graphic preview of the file.
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.2 Import a picture: Select the “Color Pastels.tif” file in the “Lesson 3”
folder, then click Open.

.3 Resize the picture: Drag the pointer to highlight the 100% value in the
X% field on the right side of the Measurements palette. Enter 175 to

scale the picture horizontally.

Press Tab to highlight the 100% value in the Y% field on the right side of the
Measurements palette. Enter 175 to scale the picture vertically.

Press Return/ENTERr.

The X% and Y% fields reflect the scale of the picture.

H Resizing pictures: To manually resize a picture and its picture box with-
out retaining the picture’s aspect ratio, press C/CTRL and drag a resizing

handle. To resize a picture and its picture box, retaining the aspect ratio of
both, press C+Option+Shift (Mac OS) or CTRL+ALT+SHIFT (Windows) and drag a
resizing handle. You can also resize a picture using the Scale Across and Scale
Down fields in the Picture tab of the Modify dialog box (Item menu), or the
X% and Y% fields of the Measurements palette. 
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Creating Visual Effects with Pictures

There are a variety of ways you can use picture files to create visual effects in
QuarkXPress. For example, you can rotate pictures, change the way text flows
around them, or partially overlap two versions of the same picture. In this task
you will superimpose a grayscale version of the artists’ pastels file over the origi-
nal picture to create a special effect.

J Keyboard Commands for Mac OS:

Step and Repeat  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+D

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+E

J Keyboard Commands for Windows:

Step and Repeat  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+D

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+E

.1 Duplicate a picture box: Make sure the picture box is still active. Choose
Item & Step and Repeat to open the Step and Repeat dialog box.

The Step and Repeat dialog box box lets you specify the number of copies
QuarkXPress makes of an active item, and how far the copies are offset hori-
zontally and vertically from the original and each other.

Enter 1 in the Repeat Count field to create a single copy of the picture and the
picture box. 

Enter 0 in the Horizontal Offset and Vertical Offset fields to place the duplicate
picture box directly on top of the original, then click OK.
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.2 Import a picture: Choose File & Get Picture. Select the “Gray Pastels.tif”
file, then click Open. The “Color Pastels.tif” file is replaced by the new

picture file.

.3 Resize the picture: Highlight the 100% value in the X% field on
the right side of the Measurements palette. Enter 175 to scale the

picture horizontally.

Press Tab to highlight the 100% value in the Y% field of the palette. Enter 175
to scale the picture vertically.

Press Return/ENTERr.

The X% and Y% fields reflect the scale of the picture.
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.4 Resize the picture box: To display the Resizing pointer f, move the
Item tool e or the Content tool E over the resizing handle at the top

of the picture box.

Using the value in the Y field of the Measurements palette as a reference, drag
the resizing handle down to approximately 7".

The duplicate picture box has been resized, revealing the color picture behind.
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H Duplicate versus Step and Repeat: The Duplicate command (Item menu)
automatically creates a single copy of an active item and positions it

according to the offset values in the Step and Repeat dialog box. The preset
default horizontal and vertical offset values are .25". The Step and Repeat
command (Item menu) opens the Step and Repeat dialog box which lets
you create multiple copies of active items and specify where they are placed.
When you duplicate or step and repeat boxes, their contents are duplicated
as well.

H Switching between the Item tool e and the Content tool E: To
toggle between the Item tool e and the Content tool E, press Shift+F8.

To temporarily access the Item tool e while the Content tool E is selected,
press C/CTRL.

H Speeding up screen redraw: When you scroll or switch pages,
QuarkXPress has to redraw all the elements on the page. Depending on

the document and the speed of your machine, screen redraw can be slow and
frustrating. To save time on screen redraw, you can “greek” pictures by checking
Greek Pictures in the General tab of the Document Preferences dialog box
(Edit menu). Picture boxes display as gray (except when selected), making it
faster to move throughout your document.
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Applying Styles to Pictures

Using the Style menu, you can convert a picture to a negative, change its
color, shade, contrast, horizontal flip and vertical flip, and control the way
in which an electronic halftone is created. In this task you’ll adjust a picture’s
shade and contrast.

J Keyboard Commands for Mac OS:

Picture Contrast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+C

J Keyboard Commands for Windows:

Picture Contrast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+O

.1 Change the contrast of a picture: Make sure the picture box containing
“Gray Pastels.tif” is active. Choose Style & Contrast.

The Picture Contrast Specifications dialog box lets you modify the contrast of
color or grayscale TIFF pictures, or color bitmap pictures. Available controls vary
depending on the picture type.
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Click the Posterized Contrast tool *, then click OK. The picture’s display is
converted to just six shades of gray based on its original shades.

The Posterized Contrast tool * lets you display and print grayscale pictures in black,
white, and four shades of gray (20%, 40%, 60%, and 80%). You can also display and
print each of the color components of a color picture in full color, white, or one of four
shades (20%, 40%, 60%, and 80%), depending on the component’s original shade.

.2 Reduce the tonal saturation of the picture: Choose Style &
Shade & 90%.

H Modifications to a picture file: Contrast modifications made in
QuarkXPress affect only the way QuarkXPress displays and prints an

imported picture; the original picture file is unaffected.
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Copying a Picture Box and Replacing its Contents

Copying and pasting is a useful way to duplicate items or contents and move
them from one document page (or document) to another. To copy or paste items
you must select the Item tool e. To copy or paste contents you must select the
Content tool E. In this task you’ll copy a picture box from the first page of a
document, paste it on the second page, and import a new picture into the box. 

J Keyboard Commands for Mac OS:

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+V

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+E

Runaround  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+T

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+W

J Keyboard Commands for Windows:

Copy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+C

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+V

Get Picture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+E

Runaround  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+T

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+F4

.1 Select the Item tool e: If it isn’t selected, click the Item tool e.

.2 Copy a picture box: Select the picture box containing the “Color
Pastels.tif” picture file. Choose Edit & Copy.

.3 Paste the picture box on the second page of the document: Scroll to
page 2 or choose Page & Next. Choose Edit & Paste.

.4 Position the picture box on the page: Enter these settings in the
Measurements palette, then press Return/ENTERr to precisely position

the picture box:

Field Setting

X (horizontal position of upper left corner of box) 5.75"
Y (vertical position of upper left corner of box) 0"

.5 Import a picture: Choose File & Get Picture. Select the “RGB Rose.tif”
file, then click Open.
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.6 Reposition the picture within the picture box: Enter these settings in
the Measurements palette, then press Return/ENTERr to precisely posi-

tion the picture within the box:

Field Setting

X+ (horizontal position of upper left corner of picture) -2"
Y+ (vertical position of upper left corner of picture) -1"

.7 Specify Runaround for the picture box: Make sure the picture box is
still active. Choose Item & Runaround to open the Modify dialog box

with the Runaround tab displayed.

The Top, Left, Bottom, and Right fields in the Runaround tab let you specify
runaround for each side of a box independently. (The 18 pt setting in the Right

field was copied along with the original picture box.)

Enter 18 in the Left field, then click OK to reflow the text 18 points to the left
of the picture box.
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.8 Close and save the document: Choose File & Close. If you haven’t
recently saved your document, a dialog box asks you to save it. Click Yes.

H Repositioning pictures within their boxes: To reposition a picture within
an active picture box, select the Content tool E, then move the Arrow

pointer a over the box. The arrow changes to the Picture Mover pointer H. Click
and drag the picture. You can also reposition a picture inside its box by enter-
ing values in the Offset Across and Offset Down fields in the Picture tab of
the Modify dialog box (Item menu).
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Checkpoint

Confirm your new skills — then try them out. If you have any questions, ask
your instructor or consult “The Details” section of this lesson.

How are you doing?

Make sure you can:

• Create a new picture box

• Set text runaround

• Import pictures

• Duplicate picture boxes and superimpose pictures

• Apply styles to pictures

• Reposition a picture within its picture box

On your own

Experiment with new documents or open some of the other lesson files.
Try the following:

• Create a few more picture boxes.

• Change the sizes of picture boxes and pictures manually using the
Measurements palette or the Modify dialog box.

• Copy a picture box and paste it in a new location — paste a picture box
on top of a text box and see how the text reflows, then change the
runaround settings.

• Copy a picture from one picture box and paste it into another.

G The lesson files are all templates, which means you can open copies
of them without affecting the original files.
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Runaround

The QuarkXPress text runaround feature lets you control the way text runs
behind, around, or within items and pictures. You can specify text to run
around the actual item, or you can create custom runaround paths and
manually modify them.

Running text around all sides of an item

Text runaround defaults to running around three sides of an item. To cause text
to run around all sides of an item, you must select the text box containing the
text (rather than the item stacked in front of it). To force text to run around all
sides of an item:

.1 Select a text box with either the Content tool E or the Item tool e.

.2 Choose Modify (Item menu); then click the Text tab. 

.3 Check Run Text Around All Sides. Click OK.

Running text around picture boxes

To specify text runaround for a picture box in front of a text box, select the
picture box, then choose Runaround (Item menu). Choose an option from
the Type menu:

• Choose None to run text behind an active picture box.

• Choose Item to run text around the picture box. If the picture box is rectan-
gular, enter values in the Top, Left, Bottom, and Right fields to outset or inset
the runaround area. If the picture box is not rectangular, a single Outset field
is provided. Modifying any aspect of the picture box will automatically update
the runaround area. 

• Choose Auto Image to create clipping and runaround paths for a picture
simultaneously. A clipping path based on “non-white areas” is generated
from the high-resolution picture file; text wraps around the path automati-
cally. The clipping and runaround paths are uneditable so the Clipping tab
controls in the Modify dialog box (Item menu) and the Clipping Path and
Runaround options of the Edit submenu (Item menu) are unavailable.

• Choose Embedded Path to run text around a path embedded in an image.
If the picture file contains more than one embedded path, choose a path
from the Path menu.
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• Choose Alpha Channel to run text around an alpha channel embedded in
an image. If the picture file contains more than one embedded alpha chan-
nel, choose an alpha channel from the Alpha menu.

• Choose Non-White Areas to create a runaround path based on a picture’s
subject. Using the Threshold value to distinguish dark pixels from light
pixels, QuarkXPress creates a runaround path that outlines a dark figure
within a white or near-white background (or vice versa). 

• Choose Same As Clipping to set the text runaround path to use the clipping
path selected in the Clipping tab of the Modify dialog box (Item menu).

• Choose Picture Bounds to run text around the rectangular “canvas area” of
an imported picture file. Enter values in the Top, Left, Bottom, and Right
fields to specify the outset or inset of the text from the picture’s boundaries.
Negative values result in an inset, positive values in an outset.

Running text around text boxes

To specify runaround for a text box in front of another text box, select the front
text box; then choose Runaround (Item menu). Choose an option from the
Type menu: 

• Choose None to run text behind an active text box.

• Choose Item to run text around an active text box. If the text box is rectan-
gular, enter values in the Top, Left, Bottom, and Right fields to outset or
inset the runaround area. If the text box isn’t rectangular, a single Outset
field is provided. Modifying any aspect of the text box will automatically
update the runaround area. 

Running text around lines and text paths

To specify text runaround for lines and text paths in front of a text box, select
the line or text path; then choose Runaround (Item menu). Choose an option
from the Type menu:

• Choose None to run text behind an active line or text path.

• Choose Item to run text around an active line or text path. (The text will only
run around the path, not the text on the path.) Modifying any aspect of the
line or text path will automatically update the runaround area. 

• Choose Manual to run text around an active line or text path. Choosing
Manual makes the Runaround path available for editing. You can move or
rotate the line or text path, but if you modify other aspects of the line or text
path such as its width, the runaround will not update (like it does when Item
is chosen). You must manually update the runaround path.

110



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 3: Picture Fundamentals

The Details: Runaround

G You can specify a runaround Outset when either Item or Manual is
chosen from the Type menu. Positive values result in runaround that

extends outward from the original setting, negative values decrease the
amount of item displayed.

H Embedded paths and alpha channels: Image-editing applications are
capable of embedding paths and alpha channels in an image. If a picture

storing this information is imported into QuarkXPress, you can access the path
and channel information using the Runaround and Clipping commands (Item
menu). QuarkXPress can scan the paths and channels and create QuarkXPress
runaround and clipping paths based on the information.

H Clipping paths and high-resolution picture files: Clipping paths cre-
ated by QuarkXPress are not built into the picture file like those created

in image-editing applications. They are based on the high-resolution picture
file, but are stored in your QuarkXPress document.

H The best images for generating Non-White Areas paths: Non-White
Areas works best when the unwanted parts of an image are much lighter

than the subject itself (or vice versa). If your grayscale or color image has a simi-
lar tonal value throughout the picture, QuarkXPress will have a difficult time
reading the subject’s outline, and won’t be able to create a very accurate path.

H File formats that include embedded path and alpha channel informa-
tion: TIFFs can have embedded paths and alpha channels. EPS, JPEG, and

Scitex CT picture files can only have embedded paths. QuarkXPress can read
embedded paths saved in any Adobe Photoshop image readable by QuarkXPress.
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Picture File Formats

Pictures are created in many ways: They are scanned, created with digital cameras,
captured from video, read from CD-ROMs — even created from scratch in certain
applications. Pictures can be stored in dozens of different formats. QuarkXPress
lets you import pictures in a variety of file formats. However, because there are
so many different ways to create and store graphic data, QuarkXPress can only
manipulate files stored in certain file formats. Some common file formats, includ-
ing their main features are:

• DCS 2.0 (Desktop Color Separations). An EPS graphic saved as a single file. Includes
up to six plates (cyan, magenta, yellow, black, and two spot colors), and a master
image for composite printing. Prints faster than a standard EPS. Can contain
bitmap and object-oriented information. Supports bitmap, grayscale, RGB, spot,
and CMYK color models. DCS 1.0 — also known as “five-file format” — contains
five separate files: cyan, magenta, yellow, and black plate files, as well as a master file.

• EPS (Encapsulated PostScript). Can contain bitmap and object-oriented informa-
tion. Supports bitmap, grayscale, RGB, CMYK, spot, and indexed color models.
Allows creation of embedded paths, inclusion of low resolution previews for
screen display and non-PostScript printing, and inclusion of OPI comments. In
ASCII format, can be opened and “read” in a text editor.

• GIF (Graphics Interchange Format). Windows file format originally developed by
CompuServe to transfer graphic files between computer systems. Popular for
the Internet World Wide Web. Supports bitmap information up to 256 colors.

• JPEG (developed by Joint Photographic Experts Group). A lossy compression format
in which there is some loss of data and possibly some degradation of quality.
Lossy compression often produces smaller file sizes and faster rendering than
lossless compression. Popular for transmission over the Internet due to extreme
compression and support for 24-bit color. Contains bitmap information only.
Can require QuickTime system extension for decoding images. Supports
grayscale, RGB, and CMYK color models.

• PhotoCD. Proprietary Kodak format for storage on CD-ROMs. Contains
bitmap information only. Supports grayscale, RGB, and Lab color models.

• PICT. Native to Mac OS. Based on original QuickDraw drawing routines.
Contains bitmap and object-oriented information.

• TIFF (Tagged Image File Format). Allows lossless compression if source applica-
tion supports it. Can also allow JPEG compression. Contains bitmap informa-
tion only. Supports bitmap, grayscale, RGB, and CMYK color models. Allows
inclusion of embedded paths, alpha channels, and OPI comments.

• WMF (Windows Metafile). Windows file format. Can contain both bitmap
and object-oriented information. Supports bitmap, grayscale, and RGB
color models.
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• BMP (Windows bitmap). Windows file format. Contains bitmap information
only. Supports bitmap, grayscale, and RGB color models.

Modifiable picture file formats

The availability of the commands in the Style menu for pictures varies depend-
ing on the file format of the selected picture.

Picture type Color Shade Negative Contrast Halftone

EPS/DCS no no no no no
GIF * * yes yes no
JPEG (*.jpg)

Grayscale yes yes yes yes yes
Color * * yes yes no

OS/2 bitmap (*.bmp)
1-bit yes yes no no yes
Color * * yes yes no

PAINT yes yes no no yes
PhotoCD no no yes yes no
Mac PICT (*.pct)

1-bit bitmap yes yes no no yes
Grayscale bitmap yes yes yes yes yes
Color bitmap * * yes yes no
Object-oriented no no no no no

Scitex CT
Grayscale * * yes yes no
Color * * yes yes no

TIFF (*.tif)
1-bit yes yes yes no yes
Grayscale yes yes yes yes yes
Color * * yes yes no

Windows bitmap (*.bmp)/PCX
1-bit yes yes yes no yes
Grayscale yes yes yes yes yes
Color * * yes yes no

WMF no no no no no

*Adjustable through the Picture Contrast Specifications dialog box which can
be opened by choosing Contrast (Style menu).
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H File filters: To import JPEG, PhotoCD, or PCX pictures, make sure you
have the appropriate XTensions software installed.

HWindows Metafile: When a QuarkXPress for Windows document with an
imported Windows Metafile (WMF) picture is opened using QuarkXPress

for Mac OS, the picture is transformed into a PICT.
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Pictures

In QuarkXPress, you can import a picture into an active picture box using the
Get Picture feature (File menu), or by pasting a picture into an active picture
box from the Clipboard.

J Keyboard Commands for Mac OS:

Center pictures within boxes  . . . . . . . . . . . . . . . . . . . .C+w+M

Nudge pictures in 1-point increments  . . . . . . . . . . . . .arrow keys

Nudge pictures in .1-point increments  . . . . . . . . . . . .`+arrow keys

Fit to picture box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+F

Fit to picture box proportionately  . . . . . . . . . . . . . . . .C+`+w+F

Decrease size by 5%  . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+<

Increase size by 5% . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+>

J Keyboard Commands for Windows:

Center pictures within boxes  . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+M

Nudge pictures in 1-point increments  . . . . . . . . . . . . .arrow keys

Nudge pictures in .1-point increments  . . . . . . . . . . . .ALT+arrow keys

Fit to picture box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+F

Fit to picture box proportionately  . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+F

Decrease size by 5%  . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+<

Increase size by 5% . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+>

Importing pictures

Begin by drawing (or selecting) a picture box. To import a picture into an active
picture box:

.1 Choose File & Get Picture. 

.2 Use the controls in the dialog box to locate and select a picture.

.3 Check Preview to display a thumbnail of the picture before importing it.
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.4 To import the selected picture, click Open (or double-click the picture’s
name in the scroll list).

G If you import a picture into a box that already contains a picture, the
existing picture will be replaced by the new one you import.

Pasting pictures

There’s a storage area in computer memory called the Clipboard that lets you
temporarily store copied and cut information, including pictures. You can
paste pictures from the Clipboard into a QuarkXPress document by selecting
a picture box with the Content tool E and choosing Paste (Edit Menu).

Although it’s convenient to copy and paste pictures, this practice should be used
with caution when pasting pictures from other applications into QuarkXPress
documents. For example, in order to edit a pasted image you must copy it, paste
it into an image-editing program, make changes, copy it again, then paste it
back into your picture box. Another disadvantage is your file size can increase
dramatically because your document contains the entire picture file rather
than a low-resolution preview. Perhaps the most important point to consider
is that color pictures pasted into QuarkXPress documents from other applica-
tions cannot be separated.

Manipulating Pictures

Once you’ve imported a picture into a picture box, there are many ways to
manipulate it. You can move, resize, scale, skew, color, and flip your picture.

Moving pictures
Move pictures within their picture boxes using:

• Item menu: Choose Modify; then click the Picture tab. Enter values in the
Offset Across field to move the picture left or right, and the Offset Down
field to move the picture up or down. Click OK.

• Tool palette: With the Content tool E selected, click the picture and drag it
around inside the picture box.

• Measurements palette: Enter values in the X+ field to move the picture left
or right, and the Y+ field to move the picture up or down. 

You can also click the N and n arrows in the Measurements palette to move
the picture in 1-point increments. Press the Option/ALT key while using
the N and n arrows to move the picture in .1-point increments.

G If the Item tool e is selected either when using the N and n arrows in the
Measurements palette or the arrow keys on the keyboard, the picture box

will move instead of the picture itself.
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Resizing pictures
You can scale pictures to make them larger or smaller using: 

• Item menu: Choose Modify; then click the Picture tab. Enter values in the
Scale Across and Scale Down fields to resize the picture. Click OK.

• Measurements palette: Enter values in the X% and Y% fields to resize the
picture, then press Return/ENTERr.

G If you rotated or skewed a picture before using the keyboard commands,
the pictures may not seem to automatically resize correctly.

Cropping pictures
If you only want a portion of your image to appear, you can crop it by adjusting
the size of the picture box.

Rotating and skewing pictures
You can manipulate pictures by adjusting their rotation and skew. Rotating
a picture sets it at a different angle, while skewing a picture applies a slanted
look to it. You can rotate or skew a picture using: 

• Item menu: Choose Modify; then click the Picture tab. To rotate a picture,
enter a value in the Picture Angle field. To skew a picture, enter a value in
the Picture Skew field. Click OK.

• Measurements palette: Enter values in the r or S fields to rotate or skew a
picture, and press Return/ENTERr.

Coloring and shading pictures
You can apply color and shade values to the shadows and middle tones of
black-and-white, grayscale, and color pictures using:

• Style menu: Choose Color, then choose a color from the submenu. Choose
Shade and choose a percentage from the submenu, or choose Other and
enter a value in the Shade field. Click OK. 

• Item menu: Choose Modify, then click the Picture tab. Choose a color from
the Colors menu. Choose a shade from the Shade menu, and click OK.

• Colors palette: Choose Show Colors (View menu). Click the picture icon p,
then click one of the colors listed. Click the arrow < next to the current shade
value to display a list of percentage values; choose a percentage from the list.
You can also highlight the current shade value in the field, enter a new value,
and press Return/ENTERr.
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Flipping pictures
You can flip the contents of a picture box from left to right, and from top to
bottom, using:

• Style menu: Choose Flip Horizontal to flip the contents of a picture box
from left to right. Choose Flip Vertical to flip the contents of a picture box
from top to bottom.

• Measurements palette: Click the horizontal flip icon ( to flip a picture
from left to right. Click the vertical flip icon ) to flip the picture from top
to bottom.

Applying contrast to pictures

Contrast manipulation lets you change the way a picture displays on screen and
in print. Contrast describes the relationship between the highlights, middle
tones, and shadows of a picture. In QuarkXPress, a picture’s contrast is displayed
as a line on a graph in the Picture Contrast Specifications dialog box (Style
menu). This line is referred to as a curve. The graph represents a picture’s contrast
by plotting input (original contrast) vs. output (displayed contrast). The curve
represents the picture’s modified tone curve. Any change to this curve affects the
image’s tone. To modify a picture’s contrast:

• Choose Contrast (Style menu).

• If you have a color picture selected, choose an HSB, RGB, CMY, or CMYK
color model from the Model menu to determine which color components
you can manipulate.

• The color components for the selected model will become available in the
Color area. For example, if you choose the CMYK model, Cyan, Magenta,
Yellow, and Black check boxes display in the Color area. Check one or
more color components to modify them.

• Use any of the nine contrast modification tools to modify the selected curve
or curves in various ways. If the picture is grayscale, one curve is available
for manipulation. If the picture is color, you can select and manipulate from
one to four curves at a time. 

• Check Negative to create a negative of the picture’s current contrast. If you have
made changes to contrast curves using the Picture Contrast Specifications
dialog box, these changes are made before Negative is applied. Checking
Negative has the same effect as choosing Negative from the Style menu.

• Click Apply to preview your changes. Press Option/ALT and click Apply to
continually apply subsequent changes to the image as you modify curves;
then click OK to accept changes.

G You can undo the most recent change to contrast curves by pressing
C+Z (Mac OS) or CTRL+Z (Windows).
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H Low-resolution preview images: When you import TIFF, RIFF, or
Scitex CT files, QuarkXPress creates a link to the high resolution picture

file and displays a low-resolution (72 dpi) preview of the image to keep file size
down and screen redraw rate up. Usually, the redraw rate is fast enough to facili-
tate productivity, but if an image is very large, it may be helpful to reduce the
resolution of its screen preview even further. Press the Shift (w) key before
you click Open in the Get Picture dialog box to create a 36 dpi preview. If
you manipulate a preview picture, the high-resolution picture prints with
your modifications. However, the original file remains untouched. 
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4
Printing a Draft
What’s Ahead

QuarkXPress supports a wide variety of print devices from 300 dots per
inch (dpi) laser printers to 2,540 dpi imagesetters. Although QuarkXPress
is used extensively to produce publications such as magazines, annual
reports, advertising layouts, and brochures requiring high-resolution
output, it is also frequently used to print to laser printers for proofing
purposes, or even for final output.

In this lesson you’ll prepare to print a simple document containing text
and pictures to a laser printer.
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Selecting a Printer

Before specifying how you want a document to print, you must select a printer
driver and an output device. Because there are so many different scenarios,
workflows, and types of printers, there are also many different printer drivers,
PostScript Printer Description (PPD) files, and printer setup options. 

A typical procedure for choosing a printer driver using a standard Mac OS or
Windows setup, is outlined below. If you’re new to the platform you’re using,
it might be helpful to consult the documentation provided with your com-
puter for complete information about using the platform, and selecting print
drivers and printers.

J Keyboard Commands for Mac OS:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+O

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+S

J Keyboard Commands for Windows:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+O

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+S

.1 If necessary, launch QuarkXPress: Locate the QuarkXPress icon and
double-click it.
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.2 Open an existing document: Choose File & Open. Open the “Module 1”
folder, then open the “Lesson 4” folder. Select the “Color Print.qxt” tem-

plate and click Open.

The first page of the existing document appears in the document window.

.3 Save the document in the Student Files folder: Choose File & Save as;
then select the Student Files folder. Enter a descriptive name like “My

Color Print Doc.qxd.” (Use the three-character extension “.qxd” in the name.) 

Verify that the Type is Document and the Version is 4.0. To create a preview
of the file (Mac OS), check Include Preview, then click Save.
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Mac OS instructions for selecting a printer

.1 Display the Chooser: From the z (Apple) menu, select Chooser. The
Chooser opens.

The Chooser lets you specify a printer driver, a network zone, a printer, whether
to setup a printer manually or automatically, whether your document is printed in
the background, and whether or not the network is active.

.2 If necessary, choose a network zone: If you’re connected to a network,
select the appropriate network zone (for example, 1st Floor) from the

AppleTalk Zones scroll list. (If your computer isn’t connected to a network,
the AppleTalk Zones scroll list is unavailable.)

.3 Select a printer driver: In the upper left corner, click a printer device icon
(for example, LaserWriter 8.3.4) from the scroll list of Chooser devices.

.4 Specify a printer: Select a printer (for example, LaserWriter 16/600)
from the Select a Postscript Printer scroll list. 

Click the close box to close the Chooser. The printer driver and printer you
specified become the defaults.

G If the Change Page Setup dialog box displays, click OK. 
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Windows instructions for selecting a printer

.1 Display the Print dialog box: Choose File & Print. The Print dialog
box opens.

The Printer menu in the Print dialog box lets you choose from a list of printers
whose printer drivers are installed on your system.
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.2 Specify a printer: Choose a printer (for example, HP LaserJet 5P/5MP
PostScript) from the Printer menu. 

G If the appropriate printer isn’t displayed in the Printer menu, have your
instructor assist you or consult the documentation resources provided

with your computer. (You can install printer drivers in the Printers Control
Panel or connect to additional printers through Network Neighborhood.)

.3 Save your new settings: Click Capture Settings to save the printer
selection and close the Print dialog box.

H PostScript Printer Description files: A PostScript Printer Description (PPD)
file contains information about the capabilities of a particular printer used

by desktop publishing applications such as QuarkXPress. For example, a PPD
might contain information about the halftone screen frequency of an output
device or about the size or type of output media it supports.

H Using Capture Settings: Capture Settings lets you save the settings
(except Copies and Pages) you’ve specified in the Print dialog box and

close it without printing the document.
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Updating Missing or Modified Pictures

When you import a picture, QuarkXPress displays a low-resolution preview of
the picture in the document and maintains a link to the high-resolution picture
file. When printing, the program retrieves the high-resolution information from
the original picture files. If you move, rename, or modify pictures (using another
program) after importing them, you should update the files prior to printing. In
this task you’ll update two pictures in your document.

.1 Display the Usage dialog box: Choose Utilities & Usage. The Usage
dialog box opens. Click the Pictures tab.

The Pictures tab in the Usage dialog box lets you verify the status of picture files
and update missing or modified files.
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.2 Update a missing picture file: Click “Color Pastels.tif” in the scroll list.
Notice the file is listed as Missing in the Status column. Click Update.

The Find dialog box opens.

The Find dialog box lets you navigate to missing picture files.

Navigate to the “Color Graphics” folder, then select the “Color Pastels.tif” file
in the scroll list. 

Click Open. The link to the file is re-established and the Status changes to OK.

The link to the “Color Pastels.tif” file has been updated.
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.3 Update a modified picture file: Click “Gray Pastels.tif” in the scroll list.
Notice the file is listed as Modified in the Status column.

The “Gray Pastels.tif” file has been modified since it was imported.

Click Update. A dialog box asks if you want to update the link.

Modified picture files can be updated by clicking OK in this dialog box.

Click OK. Notice that the link to the file is updated so the Status column now
indicates the file is OK.

129



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 4: Printing a Draft

The Steps: Updating Missing or Modified Pictures

The link to the“Gray Pastels.tif” file has been updated.

Click Done to close the Usage dialog box.

H Low-resolution preview images: When you import a TIFF, RIFF, or Scitex
CT file, QuarkXPress creates a link to the high-resolution picture file and

displays a low-resolution (72 dpi on Mac OS, 96 dpi on Windows) preview of
the image to keep file size down and screen redraw rate up. If you manipulate a
preview picture, the high-resolution picture prints with your modifications, but
the original file remains untouched. 

H Picture paths: If you keep your pictures in the same folder as your
QuarkXPress document, you won’t have to maintain picture paths.

QuarkXPress can always “find” pictures that are in the same folder as the
document, whether or not the picture was in that folder at the time it
was imported.
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Specifying Printing Options

QuarkXPress provides numerous printing options that give you a great deal of
control over the printing process. In this task you’ll select options for printing
a grayscale composite representation of your document.

J Keyboard Commands for Mac OS:

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+P

J Keyboard Commands for Windows:

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+P

.1 Display the Print dialog box: Choose File & Print. 

131



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 4: Printing a Draft

The Steps: Specifying Printing Options

.2 Specify printing options in the Document tab: Click the Document
tab. To print a composite of your document, make sure Separations is

unchecked. To omit crop marks and registration marks from your output,
make sure Registration is Off.

The Document tab of the Print dialog box lets you specify a variety of print options.
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.3 Specify printing options in the Setup tab: Click the Setup tab, then
choose the printer you selected at the beginning of this lesson from the

Printer Description menu.

Make sure the value in the Reduce or Enlarge field is 100% to print your
document full-size.

The Setup tab of the Print dialog box displays settings for the selected printer.
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.4 Specify printing options in the Output tab: Click the Output tab, and
make sure Print Colors is set to Grayscale to print the color pictures in

your document as shades of gray.

Make sure Halftoning is set to Conventional to have QuarkXPress calculate
halftone screen values.

The Output tab of the Print dialog box lets you specify color, resolution, and
halftone screen and angle settings.
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.5 Specify printing options in the Options tab: Click the Options tab,
and make sure Quark PostScript Error Handler is unchecked to disable

PostScript error reporting. 

In the Pictures area, make sure Output is set to Normal to provide high-
resolution output of imported picture files.

The Options tab of the Print dialog box lets you specify settings for reporting
PostScript errors, printing negatives, and printing pictures.
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.6 Check printing specifications in the Preview tab: Click the Preview tab,
then notice the blue outline on the page icon at the right of the Preview

tab. This outline indicates how the placement of the document page relates to
the paper as it comes from the printer.

The Preview tab of the Print dialog box lets you view the effect of your settings
before you print your document.
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.7 Print the document: At the top of the Print dialog box, make sure the
value in the Copies field is 1, and All is displayed in the Pages field.

Click Print. (If you’re not printing at this time, you can click Capture Settings
to save your print specifications with the document.)

Click Print to print your document according to the options you have specified in
each tab of the Print dialog box.

H Managing PPDs: You can use the PPD Manager dialog box (Utilities menu)
to customize the list of PPDs available from the Printer Description menu

in the Setup tab of the Print dialog box (File menu).

H Printing to a non-Postscript device: When you print to a non-PostScript
device, you don’t have the ability to print separations, scale your docu-

ment, or specify a number of other options in the Print dialog box.
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H Troubleshooting PostScript errors: If a PostScript error occurs during
printing, the Quark PostScript Error Handler can help you determine

why and where the error occurred. When it is enabled, the built-in error han-
dler prints documents up to the point of the error and provides a report that
can be useful in further pinpointing the problem. To enable the error handler,
check Quark PostScript Error Handler in the Options tab of the Print dialog
box (File menu). You can also enable the error handler through Print Styles
(Edit menu).

H Printing quick drafts for text proofing: If you need to print a document
just to proof the text, choose Low Resolution or Rough from the Output

menu in the Options tab of the Print dialog box (File menu). Low Resolution
prints imported pictures at screen preview resolution; Rough suppresses printing
of imported pictures. Both options result in faster processing and printing times.

H Using Capture Settings: Capture Settings lets you save the settings
(except Copies and Pages) you’ve specified in the Print dialog box and

close it without printing the document.
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Checkpoint

Confirm your new skills — then try them out. If you have any questions, ask
your instructor or consult “The Details” section of this lesson.

How are you doing?

Make sure you can:

• Select a print device

• Update picture files

• Specify printing options

On your own

Experiment with new documents or open some of the other lesson files.
Try the following:

• Choose a different printer if one is available.

• Move a picture file to a new folder, then update its path in your document.

• Open the Print dialog box and examine additional options in the tabs.
Choose options you’re curious about, and if possible, print your document
to see the effect of the options.

G The lesson files are all templates, which means you can open copies of
them without affecting the original files.

139



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 4: Printing a Draft

The Details: Usage Dialog Box

Usage Dialog Box

QuarkXPress doesn’t include high-resolution information with imported high-
resolution pictures (such as TIFF files). Instead, it includes low-resolution pre-
views and maintains links to original picture files. High-resolution information
is retrieved when printing. To check or update the status of imported pictures,
use the Pictures tab of the Usage dialog box (Utilities menu).

Verifying status

The Usage dialog box displays a list of imported pictures in an active document,
as well as their status:

• Print indicates whether or not a picture will print. If a check appears in the
Print column, the file will print; click the checkmark to suppress printing.

• Name indicates the file name and includes a brief path to the picture file.

• Page indicates the document page where the picture appears. If a dagger †
precedes the page number, the picture is on the pasteboard near the page.

• Type indicates the type of file format, such as TIFF or EPS.

• Status indicates the state of the picture. OK indicates that QuarkXPress can
locate the picture file and it has not been modified. Missing indicates that
the picture file has changed location or its file name is different. Modified
indicates that the picture file’s Last Modified (date and time) is different from
when it was imported.

• Check More Information to display the full path to a picture file, its file size,
modification date, dimensions, resolution, and colors.

Updating pictures

You can use the Usage dialog box to update the link to picture files:

• To locate a missing picture file, highlight the file name and click Update; the
Find dialog box lets you preview picture files, so you can locate the appropriate
picture file. If other Missing files are in the same folder, a dialog box lets you
update all of them simultaneously. Click Open to re-establish the link.

• To update a modified picture file, click Update; every instance of the modified
picture in the document will be updated.

• Click Show Me to locate and view a picture in your document.

• Check Print to make a picture print, uncheck Print to suppress printing.

• Click Done to close the dialog box.
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H Updating pictures maintains attributes: When you use Update in the
Usage dialog box (Utilities menu) to update a picture file, the picture’s

offset, rotation, and other modifications are remembered. If you reimport a
picture using the Get Picture dialog box (File menu), any modifications are lost.

H Updating pictures automatically: You can use Auto Picture Import to
check high resolution pictures when you open a document. The program

checks for changes in a high resolution data file’s name, modification date, and
location. The Auto Picture Import menu in the Document Preferences dialog
box (Edit menu) has three options: Off, On, and On (verify). Off disables auto
picture import. On automatically reimports modified pictures when you open a
document. On (verify) lets you control which pictures are updated. When the
Auto Picture Import feature updates a file, modifications are remembered. 

141



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 4: Printing a Draft

The Details: Print Dialog Box

Print Dialog Box

The Print dialog box (File menu) provides options for specifying the number of
copies to print, the pages to print, etc. at the top of the dialog box. The majority
of the QuarkXPress-specific controls reside in the lower half of the Print dialog
box and are consolidated into five tabs: Document, Setup, Output, Options,
and Preview. Each tab contains a unique set of options.

Document tab

The Document tab is the first tab in the Print dialog box. You can use its
options as follows:

• To print color separations, check Separations. A plate will print for each
spot color or process ink used in your document.

• To print document pages in a spread (two or more adjoining pages),
check Spreads.

• To print multiple collated copies of a document, check Collate. The document
is sent to the printer as though you were executing more than one Print com-
mand, so it takes longer to print than multiple copies uncollated.

• To print pages that are blank, check Include Blank Pages.

• To print multiple pages of a document as reduced-sized thumbnails on one
sheet of paper, check Thumbnails.

• To print document pages in reverse order, check Back to Front. The last page
in the document will print first.

• To specify a page sequence, choose All, Odd, or Even from the Page Sequence
menu. All (the default setting) prints the entire document. Odd forces only
odd-numbered pages to print. Choosing Even forces only even-numbered
pages to print.

• To specify that crop marks and registration marks print on every page, choose
Centered or Off Center from the Registration menu.

• To print a document in tiles (sections), choose an option from the Tiling menu.
Each document page is printed in two or more overlapping tiles. You can choose
Manual tiling or Automatic tiling. Manual lets you control page tiling by
positioning the ruler origin. When you select Automatic, QuarkXPress deter-
mines how many tiles are needed to print the document based on document
size, the printer’s media (paper) size, whether or not Absolute Overlap is
checked, and the value entered in the Overlap field (the default overlap is 3").
QuarkXPress prints tickmarks and location information on each tile to aid you
in reassembling them. Do not check Absolute Overlap if you want your docu-
ment centered on the final assembled tiles.

• To specify a bleed amount for a document, enter a value in the Bleed field.
The bleed value determines how far an item can extend beyond the page.

142



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 4: Printing a Draft

The Details: Print Dialog Box

Setup tab

The Setup tab lets you specify printer type, plus paper and page options:

• To specify a PostScript Printer Description (PPD) file for the PostScript printer
you’re printing to, choose a PPD from the Printer Description menu. Default
information supplied by the PPD is automatically entered in the Paper Size,
Paper Width, and Paper Height fields. If you choose an imagesetter PPD, the
Paper Offset and Page Gap fields are available. If the PPD you want isn’t
present, choose a similar, generic PPD.

G PPDs are created by printer manufacturers and are usually supplied
with PostScript printers. Contact the printer manufacturer for

more information.

• To choose the media size used by your printer, use the Paper Size menu.

• To specify the width and height of custom media supported by your printer,
choose Custom from the Paper Size menu and enter values in the Paper
Width and Paper Height fields.

• To make your document print smaller or larger, enter a percentage value in
the Reduce or Enlarge field. The default is 100%.

• To position your document on the selected media, choose an option from the
Page Positioning menu. The default option is Left Edge, which positions the
top left of the document page on the top left of the media. Right Edge posi-
tions the top right of the document page on the top right of the media. Center
centers the page horizontally and vertically in the imageable area of the media.
Center Horizontal centers the page left-to-right in the imageable area. Center
Vertical centers the page top-to-bottom in the imageable area.

• Check Fit in Print Area to reduce or enlarge a page to fit the imageable area
of the media.

• Click an Orientation option to print in Portrait (vertical) or Landscape
(horizontal) mode. Portrait is the default. 

Output tab (color separations off)

The Output tab lets you specify color, resolution, and halftone screen and angle
settings. To specify Output tab settings for printing with color separations off:

• From the Print Colors menu, choose Black & White, Grayscale, or Composite
Color. Black & White prints black and white (no shades of gray) to a black and
white printer. Grayscale prints colors as shades of gray to a black and white
printer. Composite Color prints colors to a color printer. The options available
in the Print Colors menu are determined by the PPD selected in the Printer
Description menu (Setup tab).
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• You can choose from two options in the Halftoning menu. The Conventional
option displays halftone screen values as calculated by QuarkXPress. Printer
uses the printer’s halftone screen values.

• The printer’s default resolution is entered automatically in the Resolution field.
To specify another resolution, enter a dots per inch (dpi) value, or choose an
option from the Resolution menu.

• The default line frequency for a printer is entered automatically in the
Frequency field. To specify another line frequency, enter a lines per inch (lpi)
value, or choose an option from the Frequency menu.

• The scroll list at the bottom of the Output tab lists Process Black as the only
color used to print your document. If a color PPD is selected, the appropriate
color plates display in the scroll list.

Output tab (color separations on)

To specify Output tab settings for printing with color separations on:

• From the Plates menu, choose Process & Spot or Convert to Process.
Process & Spot prints all process and spot color plates. Convert to Process
converts all colors in your document to process colors (at print time only)
and prints process plates.

• Conventional is the only option available from the Halftoning menu when
Separations is checked in the Document tab. Conventional displays halftone
screen values as calculated by QuarkXPress.

• The printer’s default resolution is entered automatically in the Resolution
field. To specify another resolution, enter a dots per inch (dpi) value, or
choose an option from the Resolution menu.

• The default line frequency for a printer is entered automatically in the
Frequency field. To specify another line frequency, enter a lines per inch
(lpi) value, or choose an option from the Frequency menu.

• The scroll list at the bottom of the Output tab lists the color plates used in a
document, as well as the default Halftone, Frequency, Angle, and Function
settings. You can change these specifications when default screen values will
result in moirés (undesirable patterns that can result if two or more halftone
screens are improperly superimposed when printing), or when you want
alternate dot shapes in printed screens.

• The Print column displays checks for all plates by default, indicating all plates
will print: To cancel printing for an individual plate uncheck it, or select No in
the Print menu.

• When Separations is checked (Document tab), the Plate column lists all spot
colors and process inks used in the document. 
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• The Halftone menu lets you assign a process color screen angle, frequency,
and function to a spot color. The default screen values for spot colors are
specified in the Halftoning menu in the Edit Colors dialog box (Edit menu).
Frequency, Angle, and Function for process colors can be edited in the appro-
priate columns in the scroll list.

• The Frequency column lists the line screen frequency value. This is the lines
per inch (lpi) that will be applied to each of the color plates. Choose Other
from the Frequency menu to display the Frequency dialog box. You can enter
a lines per inch (lpi) value in the Frequency field; then click OK.

• The Angle column lists the screen angle for each color plate. Choose Other
from the Angle menu to display the Angle dialog box. You can enter a screen
angle value in the Angle field.

• The Function column menu lists the available dot shape types: Default, Dot,
Line, Ellipse, Square, and Tri-Dot. Choose an alternate dot shape type, or
keep the default setting.

Options tab

The Options tab lets you specify settings for reporting PostScript errors, printing
negatives, and printing pictures. 

• To obtain printed PostScript error information, check Quark PostScript
Error Handler. If an error occurs while printing a QuarkXPress item, the
page containing the item will print up to the point of the error. The error
report contains: (1) The bounding box of the item in which the error occurred,
identified by a black border and a 50% black background. (2) A message at the
top left of the page specifying the type of item causing the error. You can lay
the error report on top of the printed page to isolate the offending item. Quark
PostScript Error Handler is designed for PostScript printing; it will append its
report to any other PostScript error reporting utilities you may be using. It will
not affect QuickDraw printing (Mac OS) or non-PostScript printing in general
(whether Mac OS or Windows).

• The Page Flip menu lets you choose from four options: None, Horizontal
(reverses the printing of page images from left to right); Vertical (prints page
images upside down); and Horizontal & Vertical (prints page images from
left to right, upside down).

• To print negative page images, check Negative Print. When Negative Print
is checked, flipping a page horizontally or vertically produces right-reading,
emulsion-down film output, a common standard for commercial printers in
the United States.

• To specify how pictures are printed, choose an option from the Output menu.
Normal (the default) provides high-resolution output using data from the
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pictures’ source files; Low Resolution prints pictures at screen preview
resolution. Rough suppresses printout of pictures.

• From the Data menu, choose ASCII, Binary, or Clean 8-bit. Though Binary
files print more quickly, ASCII files are more portable because it’s a standard
format readable by a wider range of printers and print spoolers. Clean 8-bit
combines ASCII and Binary in a versatile, portable file format.

• To specify whether TIFF and EPS pictures are output or OPI (Open Prepress
Interface) comments are substituted, choose an option from the OPI menu:

Use the default setting, Include Images, when you’re not using an OPI
server. Include Images doesn’t embed OPI comments for EPS pictures; if a
high-resolution file can’t be found, the screen preview is substituted.

Choose Omit TIFF when you’re outputting to an OPI prepress system that
replaces TIFF pictures only. (Most OPI systems use this method.) Omit TIFF
replaces TIFF pictures with OPI comments. EPS pictures are included; OPI
comments for the EPS pictures aren’t included.

Choose Omit TIFF & EPS when you’re outputting to an OPI prepress system
that replaces both TIFF and EPS pictures. Omit TIFF & EPS replaces both TIFF
and EPS pictures with OPI comments. (Consult documentation provided by the
OPI system manufacturer for more information.)

• Check Overprint EPS Black to force all black elements in imported EPS
pictures to overprint regardless of their overprint settings.

• To print TIFFs at the full printer resolution, check Full Resolution TIFF
Output. QuarkXPress sends the TIFF information to the printer based on the
resolution (dpi) of the printing device. If Full Resolution TIFF Output isn’t
selected, a non line-art TIFF will be downsampled based on the frequency
(lpi) setting for the session (line-art TIFFs are sent at full printer resolution).

Preview tab

The Preview tab lets you view the effect of settings before you output a print
job. The page icon shows the document page in relationship to its placement
on the output media. Statistical information about the page also displays.

H Preventing a picture from printing: When printing a draft, you may
need to print some pictures, but not all. You can prevent a picture (and its

box) from printing by checking Suppress Printout in the Box tab of the Modify
dialog box (Item menu). To supress the picture printout, but print its box, check
Suppress Picture Printout in the Picture tab.

146


	Table of Contents
	Introduction
	Getting Started
	Conventions
	Setting Up

	Lesson 1: The Concepts
	The Steps
	Opening an Existing Document
	Examining the Tool Palette
	Creating Guides
	Navigating through QuarkXPress
	Working with Items
	Modifying Items
	Working with Contents
	Using the Measurements Palette
	Checkpoint

	The Details
	Documents
	Tool Palette
	Item and Content Tools
	Rulers and Guides
	Menus and Dialog Boxes
	Measurements Palette


	Lesson 2: Text Fundamentals
	The Steps
	Creating a New Document
	Importing Text
	Creating Text Boxes
	Entering and Formatting Text
	Copying and Pasting Items
	Applying Character Attributes
	Checkpoint

	The Details
	New Documents
	Text
	Boxes
	Cut, Copy, and Paste


	Lesson 3: Picture Fundamentals
	The Steps
	Creating Picture Boxes
	Running Text Around Items
	Importing Pictures
	Creating Visual Effects with Pictures
	Applying Styles to Pictures
	Copying a Picture Box and Replacing its Contents
	Checkpoint

	The Details
	Runaround
	Picture File Formats
	Pictures


	Lesson 4: Printing a Draft
	The Steps
	Selecting a Printer
	Updating Missing or Modified Pictures
	Specifying Printing Options
	Checkpoint

	The Details
	Usage Dialog Box
	Print Dialog Box



